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Important
The following functions are for reference only. Some series products may not support all the functions
listed below.

Cybersecurity Recommendations

1. Change Passwords and Use Strong Passwords

The number one reason systems get “hacked” is due to having weak or default passwords. It is
recommended to change default passwords immediately and choose a strong password whenever
possible. A strong password should be made up of at least 8 characters and a combination of special
characters, numbers, and upper and lower case letters.

2. Update Firmware
As is standard procedure in the tech-industry, we recommend keeping NVR, DVR, and IP camera
firmware up-to-date to ensure the system is current with the latest security patches and fixes.

“Nice to have” recommendations to improve your network security

1. Change Passwords Regularly
Regularly change the credentials to your devices to help ensure that only authorized users are able to
access the system.

2. Change Default HTTP and TCP Ports:

e Change default HTTP and TCP ports for systems. These are the two ports used to communicate and
to view video feeds remotely.

e These ports can be changed to any set of numbers between 1025-65535. Avoiding the default ports
reduces the risk of outsiders being able to guess which ports you are using.

3. Enable HTTPS/SSL.:
Set up an SSL Certificate to enable HTTPS. This will encrypt all communication between your devices
and recorder.

4. Enable IP Filter:
Enabling your IP filter will prevent everyone, except those with specified IP addresses, from accessing

the system.

5. Change ONVIF Password:



On older IP Camera firmware, the ONVIF password does not change when you change the system’s
credentials. You will need to either update the camera’s firmware to the latest revision or manually
change the ONVIF password.

6. Forward Only Ports You Need:

e Only forward the HTTP and TCP ports that you need to use. Do not forward a huge range of numbers
to the device. Do not DMZ the device's IP address.

e You do not need to forward any ports for individual cameras if they are all connected to a recorder on
site; just the NVR is needed.

7. Disable Auto-Login on SmartPSS:

Those using SmartPSS to view their system and on a computer that is used by multiple people should
disable auto-login. This adds a layer of security to prevent users without the appropriate credentials
from accessing the system.

8. Use a Different Username and Password for SmartPSS:

In the event that your social media, bank, email, etc. account is compromised, you would not want
someone collecting those passwords and trying them out on your video surveillance system. Using a
different username and password for your security system will make it more difficult for someone to
guess their way into your system.

9. Limit Features of Guest Accounts:
If your system is set up for multiple users, ensure that each user only has rights to features and
functions they need to use to perform their job.

10. UPnP:

e UPnP will automatically try to forward ports in your router or modem. Normally this would be a good
thing. However, if your system automatically forwards the ports and you leave the credentials defaulted,
you may end up with unwanted visitors.

o If you manually forwarded the HTTP and TCP ports in your router/modem, this feature should be
turned off regardless. Disabling UPnP is recommended when the function is not used in real
applications.

11. SNMP:
Disable SNMP if you are not using it. If you are using SNMP, you should do so only temporarily, for
tracing and testing purposes only.
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12. Multicast:
Multicast is used to share video streams between two recorders. Currently there are no known issues
involving Multicast, but if you are not using this feature, deactivation can enhance your network security.

13. Check the Log:

If you suspect that someone has gained unauthorized access to your system, you can check the system
log. The system log will show you which IP addresses were used to login to your system and what was
accessed.

14. Physically Lock Down the Device:
Ideally, you want to prevent any unauthorized physical access to your system. The best way to achieve
this is to install the recorder in a lockbox, locking server rack, or in a room that is behind a lock and key.

15. Connect IP Cameras to the PoE Ports on the Back of an NVR:
Cameras connected to the PoE ports on the back of an NVR are isolated from the outside world and
cannot be accessed directly.

16. Isolate NVR and IP Camera Network

The network your NVR and IP camera resides on should not be the same network as your public
computer network. This will prevent any visitors or unwanted guests from getting access to the same
network the security system needs in order to function properly.

Electrical safety

® Allinstallation and operation should conform to your local electrical safety codes.

® The power source shall conform to the requirement of the Safety Extra Low Voltage (SELV)
standard, and supply power with voltage rated by DC 12 V or AC 24 V according to the Limited
power Source requirement of IEC60950-1. Please note that the power supply requirement is
subject to the device label.

® Make sure the power supply is correct before operating the device.

A readily accessible disconnect device shall be incorporated in the building installation wiring

® Prevent the power cable from being trampled or pressed, especially the plug, power socket and the
junction extruded from the device.

® \We assume no liability or responsibility for all the fires or electrical shock caused by improper
handling or installation.

Environment
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® Do not aim the device at strong light to focus, such as lamp light and sun light, otherwise it might
cause over brightness or light marks, which are not the device malfunction, and affect the longevity
of Charge Coupled Device (CCD) or Complementary Metal-Oxide Semiconductor (CMOS).

® Do not place the device in a damp or dusty environment, extremely hot or cold temperatures, or the

locations with strong electromagnetic radiation or unstable lighting.

Keep the camera away from water or other liquid to avoid damages to the internal components.

Keep the indoor device away from rain or damp to avoid fire or lightning.

Keep sound ventilation to avoid heat accumulation.

Transport, use and store the device within the range of allowed humidity and temperature.

Heavy stress, violent vibration or water splash are not allowed during transportation, storage and

installation.

® Pack the device with standard factory packaging or the equivalent material when transporting the
device.

Privacy Protection Notice

As the device user or data controller, you might collect personal data of others' such as face,
fingerprints, car plate number, Email address, phone number, GPS and so on. You need to be in
compliance with the local privacy protection laws and regulations to protect the legitimate rights
and interests of other people by implementing measures include but not limited to: providing clear
and visible identification to inform data subject the existence of surveillance area and providing
related contact.

About the Manual

® The Manual is for reference only. If there is inconsistency between the Manual and the actual product, the
actual product shall govern.

® \We are not liable for any loss caused by the operations that do not comply with the Manual.

® The Manual would be updated according to the latest laws and regulations of related regions. For detailed
information, see the paper User's Manual, CD-ROM, QR code or our official website. If there is
inconsistency between paper User's Manual and the electronic version, the electronic version shall prevail.

® All the designs and software are subject to change without prior written notice. The product updates might
cause some differences between the actual product and the Manual. Please contact the customer service for
the latest program and supplementary documentation.

® There still might be deviation in technical data, functions and operations description, or errors in print. If
there is any doubt or dispute, please refer to our final explanation.

® Upgrade the reader software or try other mainstream reader software if the Guide (in PDF format) cannot be
opened.

® All trademarks, registered trademarks and the company names in the Manual are the properties of their
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respective owners.

Please visit our website, contact the supplier or customer service if there is any problem occurred when using
the device.

If there is any uncertainty or controversy, please refer to our final explanation
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1 Product Overview

The common networking mode for IPC is to connect IPC to PC via switch or router. The common
network mode is shown in Figure 1-1.

—
Cable T Cabilia

Switch or Router

‘/ or i g
Y O =

IPC PC

Figure 1-1

Before you have access to network camera via the Internet, you need to acquire its IP address. Users
can search IP address of network camera via Quick Config Tool.



2 Initial Config

In this chapter it is to introduce the device initial config operation, which includes device initialization,
login device, log out WEB interface and password reset.

2.1 Device Initialization

It needs to implement device initialization when you use the device for the first time. Here it is to take
WEB operation as an example to introduce device initialization. You can also initialize device via Quick
Config Tool, NVR and platform etc.

Note

In order to guarantee device safety, please keep admin login password properly after device
initialization, and modify the password regularly.

Step 1

Open IE browser, input camera IP address in the address bar and click Enter.

The system will display the interface of Device Initialization after it is connected successfully, which is
shown in Figure 2-1.

Note

The default IP address is 192.168.1.108.

Device Initialization

Username admin

Password The minimum pass phrase length is 8 characters

Confirm Password

Use a password that has 8 to 32 characters, it can be a combination of letter(s),
number(s) and symbol(s) with at least two kinds of them.(please do notuse

special symbols like"™;: &)

[v] Email Address
To reset password, please input properly or update in time.

Figure 2-1

Step 2
Itis to set admin login password, please refer to Table 2-1 for more details.



Parameter Note

User name The default user name is admin

Password The password ranges from 8 to 32 digitals. It can contain letters, numbers

' and special characters (excluding “”,“"",”,“”,“&”) . The password shall

Confirm . -

password contain at least two categories. Usually we recommend the strong
password.
Input an email address for reset password purpose. In case you forgot

Email password in the future, input the security code you got on the assigned
email to reset the password of admin.

Table 2-1

Step 3
Select | have read and agree to all terms and click Next.
The system will display the interface of Easy4iP, which is shown in Figure 2-2.

Easy4ip

V| Easydip

Register device to EASY4IP and then suitable for user to apply for cloud account. It can realize cloud service such as remote
surveillance, device record, alarm, cloud storage, using device to manage cloud.

Scan and Download EASY4IP APP

Next

Figure 2-2

Step 4
Select Easy4iP according to actual needs and realize Easy4iP registration for device, click next. The
system will display the interface of Online Upgrade, which is shown in Figure 2-3



Online Upgrade

[¥] Auto-check for updates

Notify automatically when updates available. The system checks for updates every day.

Online Upgrade is a semvice that provides you with firmware updates by cloud. This service will collect device information in order to
inform you about available firmware updates. Such information may include your device name, firmware version and device
identification numbers. Such information is processed for the sole purpose of informing you about firmware updates.

Figure 2-3

Step 5

It is to set upgrade method according to the actual requirements.

Select Auto-check for upgrade and the system will check once daily automatically when there is system
upgrade prompt.

Note

After login, you can make setting in ‘Setup > System > Upgrade > Online Upgrade’.

Step 6
Click Save and device initialization is completed.

2.2 Login and Logout

Here it is to introduce device login and WEB interface logout via browser, it is to take IE Explorer 8 as

an example to make introduction.

2.2.1 Log in WEB Interface

Users can make operations such as live, playback and config upon the device after logging in device

WEB interface via browser.

Note

® |t can log in WEB interface after device initialization is completed.

® |t will prompt to install plug-in when logging in the system for the first time, please download and
install plug-in according to prompt.

Step 1



Open IE browser, input camera IP address in the address bar and click Enter button.
The system will display the Login interface after it is successfully connected, which is shown in Figure
2-4.

Figure 2-4

Step 2

Input the password of admin user.

Step 3

Click Login.

It will display the Live interface after it logged in successfully, which is shown in Figure 2-5.

Note

Different devices have different functions with different interface display; please refer to the actual
interface for more details.



IP Camera

Main St supsieami | substeamz RRedTce

Figure 2-5

2.2.2 Logout

Click Logout and return to WEB login interface. After logging in the device WEB, the system will
hibernate automatically if it fails to operate the device for a period of time. It can recover to normal
working status quickly after entering password.

2.3 Reset Password

Users can reset password via reserved email when you forget the password of admin user.

Step 1

Open IE browser, input camera IP address in the address bar and click Enter button.

The system will display the Login interface after it is successfully connected, which is shown in Figure
2-6.



IP Camera

Username: | admin

Password: [l Forgot password?

Login Cancel

Figure 2-6

Step 2
Click Forgot password?
The system will display the interface of Reset Password, which is shown in Figure 2-7.

Reset the password(1/2)
SN: 2C04ABIYAZ00019
QR code:
Note(For admin only):
Option 1. Please download Easy4ip and then from
Me-Settings-Reset device password, scan the left
QR code.
Option 2. Please use an APP to scan the left QR
code to get special strings. And then send the
strings to support_rpwd@alobal.dahuatech.com.
The security code will be delivered to 1***@gg.com
Security code:
I Cancel | | Next I
Figure 2-7

Step 3

Reset login password.

Scan the QR code according to the interface prompt and acquire security code, then input the security
code which is received via your reserved email.

Caution



® Please use the security code to reset the password within 24 hours after you received the security
code via your reserved email. Otherwise the security code will be invalid.

® |If you fail to use security code for twice continuously, then the system will prompt that it fails to
acquire security code for the third time. It needs hardware to restore device default setting and
acquire security code again or wait for 24 hours and acquire it again if it needs to use the device
normally.

Step 4
Click next.
The system will display the interface where you can set the new password, which is shown in Figure 2-8.

Reset the password(2/2)

Username admin

Password

Use a password that has 8 to 32 characters, it
can be a combination of letter(s), number(s) and
symbol(s) with at least two kinds of them.
(please do not use special symbols like "™ ;: &)

Confirm Password

| Cancel I | Save I

Figure 2-8

Step 5

Reset Password and Confirm Password.

The password ranges from 8 to 32 digitals. It can contain letters, numbers and special characters
(excluding “”,“™ %" %" “&”) . The password shall contain at least two categories. Usually we recommend
the strong password.

Step 6

Click Save and complete password reset.

The system will display the Login interface.



3 Live

After you logged in, you can see the live monitor window. See Figure 3-1.

IP Camera

1 | Main str Sub Stream 1 Sub Stream 2 AN m

Figure 3-1

There are four sections:

® Section 1: Encode setup bar

® Section 2: System menu

® Section 3: Window function option bar
® Section 4: Window adjust bar

3.1 Encode Setup

Note: Some series don’t support sub stream 2.
The encode setup interface is shown as in Figure 3-2.

Sub Stream 1 Sub Stream 2 Protocol m

Figure 3-2

Please refer to the following sheet for detailed information.




Parameter

Function

Main stream

Click it to enable main stream video monitoring and click again
to disable it. Generally for storage and monitor.

Sub Stream 1

Click it to enable Sub Stream1 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Sub Stream 2

Click it to enable Sub Stream 2 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Protocol

You can select stream media protocol from the dropdown list.
There are three options: TCP/UDP/Multicast

3.2 System Menu

System menu is shown as in Figure 3-3.

Please refer to chapter 2 Live, chapter 3 PTZ, chapter 4 Playback, chapter 5 Setup, chapter 6 Alarm,

chapter 7 Log out for detailed information.

r Live T PTZ Flalbat:k T S:Etua T Alarm Lnﬁnut ]

Figure 3-3

3.3 Video Window Function Option

The interface is shown as below. See Figure 3-4.

Please refer to the following

Figure 3-4

sheet for detailed information.

SN Parameter Function

1 Relay-out

It shows if there is any alarm output, status description is as
follows:

® Red: means there is alarm output.

® Grey: means alarm is over.

Click on the button to force alarm to be on or off.
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2 Digital ® When the video is in the original status, click it you can
Zoom select any zone to zoom in. In the non-original status,
you can drag the zoom-in zone in specified range. Right
click mouse to restore previous status.
® Click it; you can use the middle button of the mouse to
zoom in/out the video size.
3 Snapshot Click on the button to snapshot, save picture to path in Ch
5.1.2.5.
4 Triple Click it to take snapshot upon the video at the frequency of
Snapshot one picture per second. All images are saved to path in Ch
5.1.2.5.
5 Record Click it to record the video. All videos are saved to path in
Chapter 5.1.2.5.
6 Easy focus | Click it, you can see there are two parameters on the preview
video: AF Peak and AF Max.
AF Peak: It is to display the video definition during the focus
process.
AF Max: It is the most suitable value for the video definition.
The close the AF Peak and AF Max is, the better the focus
effect is.
7 Audio Turn on or off audio when you are monitoring.
8 Talk Click it to start or end bidirectional talk.
9 Help Click it to open help file.

3.4 Video Window Setup

The interface is shown as in Figure 3-5.

3.4.1 Image Adjustment

w0 = to it ©

ONONONONONONONO)

Figure 3-5

See Figure 3-6 for image adjustment.
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Click this button to display/hide image control interface. Click it to open picture setup interface. This

Figure 3-6

interface is on the top right pane.

Please refer to the following sheet for detailed information.

It is to adjust monitor video
contrastness.

It is to adjust monitor video
hue.

It is to adjust monitor video
saturation.

Reset

Restore brightness,
contrastness saturation and
hue to system default setup.

Parameter Function
Video o It is to adjust monitor video Note:
setup brightness. ® All the operations here apply

to WEB end only.

® Please go to Setup-
>Camera->Conditions to
adjust corresponding items.

3.4.2 Original Size

Click this button to go to original size. It is to display the actual size of the video stream. It depends on

the resolution of the bit stream.

3.4.3 Full Screen
Click it to go to full-screen mode. Double click the mouse or click the Esc button to exit the full screen.

12



3.4.4 Width and Height Ratio
Click it to restore original ratio or suitable window.

3.4.5 Fluency Adjustment

There are three levels of fluency for you to select (Realtime, Normal, and Fluency). The default is

normal.

3.4.6 Rules Info

Click the button, preview image will display intelligent rules after enabling; it is “Enable” by default.

3.4.7 Zoom and Focus

Click this button and the focus zooming interface appears on the right of preview interface, as shown in
Figure 3-7, click left mouse button to adjust focus zooming configuration.

Note
® The product series which support motorized zoom, synchronous focus and back focus have this
button.

® Auto-focus after zoom and focus adjustment.

Zoom and Focus

- Auto Focus

Restore All

Regional Focus

Figure 3-7
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4 Playback

Web client playback supports video playback and picture playback.
Note:
Before playback, user shall set storage management as in Ch. 5.4.

4.1 Playback

The playback interface is shown as in Figure 4-1.

IP Camera T SR R (TN AN ("

e
st sc

e < RS

Sun Mon Tue Wed Thu Fri Sat
1
21314)5)6)7]8

9110 1112 13/ 14 15

161718 19 20121 | 22

2324125126 27 28 29

3D

Al cooo00 o

Stop Record Type Al General B Motion Bl Alarm Manual B

There are four sections:

Section 1: Function of play
Section 2: Playback file
Section 3: Play time cut
Section 4: Record type
Section 5: Progress bar
Section 6: Assistant function




4.1.1 Function of Play
The function of play is shown as in Figure 4-2 and Figure 4-3.

OC0000 O =0

©Oe e 6 6 O 6-1

Figure 4-2

00000 O =0

e e 6 ©® O 62

Figure 4-3
Parameter Function
@ Pla When you see this button, it means pause or not played record. Click on this
y button, switch to normal play status.
(2) Stop Click this button to stop playing.
Click on this button to go to next frame.
(3 Play by frame Note:
You shall pause record when you use this function.
(® Slow Click on this button to play slowly.
(5 Quick Click on this button to play quickly.
® Silent When this button displays, it means audio is silent. Click on this button to
switch back to normal.
(7) Volume Click on left mouse to adjust volume.
. Click this button and fisheye device can adjust display mode according to
-1 Fisheye different installation mode during the process of playback.
Click the button and it will playback and display intelligent rules and object
-2 Rule Info detection box if the video is equipped with intelligent rule info after the
function is enabled, it is off by default.

15



4.1.2 Playback File
In calendar, blue date represents data currently has video record or snapshot. See Figure 4-4.

< 2013 S

Sun Mon Tue Wed Thu

Figure 4-4
Parameter Function
) e Select “dav”, as video playback.
File Type . .
e Select “jpg” as picture playback.
Data Source Default is SD card.

Step 1. Click on data in blue, time axis displays record file progress bar in color. While, green represents
normal record, yellow represents motion detect record, red represents alarm record, and blue
represents manual record.

Step 2. Click on certain time on progress bar, playback starts from this time. See Figure 4-5.

Figure 4-5

Step 3. Click on file list = , select date file will be displayed in list.

Step 4. Double click on file in list, playback this file and display file size, start time and end time.
See Figure 4-6.
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00 : 00 : 00 - 23 : 59 : 59 jfe¥

General, Event, Alarm, Manual «

Download Format @ dav © mp4

Start Time  File Type
15:49:39 "0
15:50:07
15:54:38
16:25:13
16:31:35
16:32:06
16:45:58
16:54:00
17:00:54

(el eleNeleNeleNe

€ €171 p pi D
Begin Time:
End Time:
File Size:

Figure 4-6
Parameter Function
BSearch It means records within searched start time and end time on the date.
Download There are two formats: dav, mp4.
Format

EDownload

® click the download button and download file to path in Ch. 5.1.2.5.
® System does not support download and playback at the same time.

17



Parameter Function

€ Back Click on back button to go to calendar interface.

4.1.3 Playback Cut

Note:

Playback cut function will automatically pause playing record as playback cut and playback cannot be at
the same time.

Step 1. Click on start time to cut on time axis. This time must be within progress bar range.

—_—

Step 2. Move mouse to cut icon gﬁ . You will be ask to select start time. Click on cur icon 5‘5 as

finish cutting.

Step 3. Click on playback cut end time on time axis. This time must be within progress bar range.
— —

Step 4. Move mouse to cut icon-& you will be asked to select end time. Click on cut icon ﬁ as
finish cutting.
Step 5. Click on Save button to save file cut to path in Ch 5.1.2.5. See Figure 4-7.

00:00:00-00:00:00 B

Figure 4-7

4.1.4 Record Type
After checking record file type, only selected file will be displayed in progress bar and file list. Users can

also select the record type to be displayed via the dropdown box which is above the file list. See Figure
4-8.

Record Type [ Al [ General [ Motion @ & Alarm & Manual W

Figure 4-8

4.1.5 Progress Bar

(3 20min

Figure 4-9
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Parameter

Function

24 hours

Click on it, means video in past 24 hours.

Ozhr |, hours Click on it, means video in past 2 hours.
Oihr |, hour Click on it, means video in past 1 hour.
(9 30min 30 min Click on it, means video in past 30 min.

4.1.6 Assistant Function
Video playback assistant function is shown in Figure 4-10.

Figure 4-10

Parameter

Function

Digital Zoom

e Click on it, video in playback status if is in original size, user can
zoom in any area, If it is not in its original size, Right mouse click to
restore its original size.

e Click on this button, you can scroll to zoom in.

E] Snapshot

Click on this button, you can snapshot video under playback status.
Snapshot will be saved to path in Ch. 5.1.2.5.

4.2 Picture Playback

Web client picture playback interface has the following three functions:

Parameter Function

1 Play function bar
2 Playback file bar
3 Snapshot type bar

See Figure 4-11.
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IP Camera

[>)

Snapshot Type All General W Event M Alarm

4.2.1 Play

Live e (LT (TR S —" —r—

Figure 4-11

oo

Figure 4-12

©)

File Type ipg E

Data Src _SD Card E
< IEGE >

Sun Mon Tue Wed Thu Fri Sat
1 213|456 )7
89101112013 ]14

7 [48) [49] 20 [21]
241251262728

31

Default icon is E and it means pause or not played picture. Click on play button to switch to

normal play status. Icon become m

Click on it to pause.
4.2.2 Playback File
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< 2013 I8

Sun Mon Tue Wed Thu Fri Sat

Figure 4-13

Step 1. Click on file list = , Select snapshot file of the date.

Step 2. Double click on file in list, to play this snapshot.

Parameter

Function

n Search

It means all snapshot files within the start time and end time of selected date.
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Parameter Function
m Click the download button to open snapshot file or directly download to local
Download according to the browser types.
L Back Click the back button to return to calendar interface and re-select time.

00 : 00 : 00 - 23 : 59 : 59 jfe}

Start Time  File Type

13:23:16
13:24:55
13:25:09
13:25:19
13:25:29
13:25:40
13:25:50
13:26:09
13:26:19
13:27:41
13:27:51
13:28:01

M <€1/1p Pl

o
o
o
V)
o
V)
o

= O
o
V)
o
V)

am

Figure 4-14

4.2.3 Snapshot Type
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After checking snapshot file type, in file list only display file of selected type. Users can also select the
snapshot type to be displayed via the dropdown box above the file list. See Figure 4-15.

Snapshot Type All General Event W Alarm

Figure 4-15
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S5 Setup

Web client setup support camera, network, time, storage, system and system info view.

5.1 Camera

The camera setting includes conditions, profile management, zoom and focus.

5.1.1 Conditions

Note:

The camera parameter may be different according to different models, please refer to the actual product
for more details.

5.1.1.1 Picture

Note:

The device which supports true WDR fails to support long exposure when true WDR is enabled.

Step 1

Select “Setup > Camera > Conditions > Picture” and the system will display the “Picture” image which is
shown in Figure 5-1.

IP Camera

Conditions  JProfile Management§ Zoom and Focus

> Video

Profile| Day [~]

g Style Standard B

» Exposure

> Audio

Network Brightness [=] O
Event » Backlight Contrast (=] O
Saturation (=] 0 50

Storage » WB

System
Y » Day & Night ]
Information
» IR Light Gamma (5]

Mirror ) ON @ OFF

Flip 0° [+]

Default I | Refresh I l Save

Figure 5-1
Step 2
Set picture parameters; please refer to the following sheet for more details about parameter setting.
Parameter Note
Style It is to set the picture style, which includes standard, soft and vivid.
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Parameter

Note

Brightness

It is to adjust the image overall brightness via linear adjustment mode.
The larger the number is, the brighter the picture is, and on the contrary it

is opposite. The picture get blurry easily when the value is set too big.

Contrast

It is to adjust the picture contrast. The bigger the value is, the bigger the
bright contrast becomes, and on the contrary it is smaller. The dark area
becomes darker and the bright area becomes overexposed easily when
the value is set too big. The picture becomes blurry when the value is set
too small.

Saturation

It is to adjust the color darkness and lightness. The color becomes darker
when the value is bigger; on the contrary it becomes lighter. The value
causes no influence to the overall brightness of the image.

Sharpness

It is to adjust the sharpness level of the picture edge. The bigger the
sharpness value is, the more obvious the image edge becomes, the image
is likely to generate noise more easily when the value is set too big.

Gamma

It is to change image brightness and improve the dynamic display range of
the image via nonlinear adjustment mode. The bigger the value is, the
brighter the picture becomes, and on the contrary it is opposite.

Mirror

After mirror is enabled, the monitoring image will be displayed invertedly.

Flip

It is to change the display direction of the monitoring image.
It includes following options:
e Normal: The monitoring picture is normally displayed.

e Flip mode 1: The monitoring picture is displayed with clockwise
rotation 90°

e Flip mode 2: The monitoring picture is displayed with anticlockwise
rotation 90°

e 180°: The monitoring picture is displayed upside down.
Note:

Please set the video resolution as 1080P or lower when applying flip mode
for some devices.

EIS

It can realize electronic anti-flicker function via comparison algorithm of
image difference, which can effectively solve the problem of image jittering
during application and it can make the image clearer.

Step 3

Click “Save” and complete the image parameter config of the camera.
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5.1.1.2 Exposure
Step 1

Select “Setup > Camera > Conditions > Exposure”. The system will display the “Exposure” interface
which is shown in Figure 5-2.

IP Camera

> Video

> Audio
Network
Event
Storage
System

Information

Profile. Normal [=]
» Picture Anti-flicker | Outdoor [=]
» Backlight Autolris @ ON () OFF
» WB o s
3DNR® ON ) OFF
» Day & Night
Y & Nig Grade (=] 0 =

» IR Light

[

Default

Refresh

| | Save ‘

Figure 5-2
Step 2
It is to set the exposure parameter, please refer to the following sheet for more details.
Parameter Note
® You can switch to exposure mode when it is in outdoor
mode, it can realize the result in the corresponding exposure
mode.
® 50Hz: When the current is 50Hz, system can auto adjust the
Anti-flicker

exposure according to the environment brightness in case
there is any stripe.

® 60Hz: When the current is 60Hz, system can auto adjust the

exposure according to the environment brightness in case
there is any stripe.
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Parameter

Note

Mode

It is the camera exposure mode.
Note:

® \When “Anti-flicker” is “Outdor”, the “exposure mode” can be
set as “gain priority” or “shutter priority” mode.

® Different devices have different exposure modes; please
refer to the actual interface.

It includes the following options:

® Auto: It can auto adjust the image brightness according to
the environment.

® Gain priority: The device can auto adjust according to the
gain range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the gain value has reached to upper limit
or lower limit, which is to make the image reach the best
brightness.

® Shutter priority: The device can auto adjust according to the
shutter range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the shutter value has reached to upper
limit or lower limit, which is to make the image reach the best
brightness.

® Iris priority: Iris value is fixed, the device can auto adjust the
shutter value if the image brightness fails to reach effect and
the shutter value has reached the upper limit or lower limit,
the device can auto adjust the gain value to make the image
reach the best brightness.

® Manual: It is to manually set gain value and shutter value,
adjust the the displayed brightness of the image.

Auto Iris

It can set the parameter when the camera installs auto iris.

® The lens iris can auto adjust the size according to the
environment after auto iris is enabled, then the image
brightness will change accordingly.

® The iris value reaches the max when disabling auto iris, the
lens iris will not change according to the environment
brightness.

3D NR

It is to process the image with multiframe (at least two frames), it
can realize noise reduction of the image by using the interframe
information between the previous and latter frame.

Grade

It can set the parameter when “3D NR” is enabled.
The bigger the grade is, the better NR effect it can realize.
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Step 3
Click “Save” to complete the parameter config of camera exposure.

5.1.1.3 Backlight

Backlight mode can be divided into BLC, WDR and HLS.

BLC: it can avoid cucoloris phenomenon of the darker area in the backlight environment.

WDR: It can suppress the overbright area and compensate darker area by enabling WDR, which can
make the overall image clear.

HLC: It is to weaken the high light, which can be applied in the areas such as toll gate, entrance and exit
of the parking lot and etc. As for extreme light, it can snapshot the human face in the dark environment
and it can realize better effect for the details of the plate number.

Step 1
Select “Setup > Camera > Condition > Backlight”, the system will display the interface of “Backlight”
which is shown in Figure 5-3.

IP Camera

Profile  Normal

> Audio [’ Ficure Mode | OFF [+]

Network e == ' - - » Exposure

Event e

Storage - » WB
System . » Day & Night

Information » IR Light

=

| Default 1 | Refresh | i Save |

Figure 5-3

Step 2

Set the backlight parameter.

® When the “Mode” is set as “Scene Self-adaptation”, the system will auto adjust the image
brightness according to the environmental brightness, which is to make the object display clearly in
the scene.

® When the “Mode” is set as “BLC”, it can select default mode or customized mode.

€ When selecting “Default” mode, the system can realize auto exposure according to the
environment, which is to make the image in the darkest area clear to be seen.
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€ When selecting “Customized” mode, the system can realize exposure upon the selected area
after it set customized area, which is to make the image of the selected area reach
appropriate brightness.
® When the “Mode” is set as “WDR”, it will lower the brightness of the area with high brightness and
enhance the brightness of the area with low brightness, which is to make the objects in both high
brightness and low brightness area display clearly.
Note:
There may be video loss of a few seconds when the camera is switched from non WDR mode to WDR
mode.
® \When the “Mode” is set as “HLC”, the system will constrain the brightness of the area with high
brightness and decrease the size of the halo area, which is to lower the brightness of the whole
image.
Step 3
Click “Save” to complete the config of the backlight mode.

5.1.1.4 WB

WB is used to restore the white object in the scene by the camera, after WB mode is set, it can make
the white object look white in different environments.

Step 1

Select “Setup > Camera > Conditions > WB”, the system will display the interface of “WB”, which is
shown in Figure 5-4.

IP camera

Profile | Normal
> Video

QLN
)
> Audio - Litiane Mode | Auto E

Network B - » Exposure
Event — » Backlight
P e,

Storage

System

» Day & Night

Information » IR Light

| Default I I Refresh I l Save |

Figure 5-4

Step 2
Set WB mode.
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® \When the “Mode” is set as “Auto”, the system can auto compensate white balance upon different
color temperatures, which is to make the image color normal.

® \When the “Mode” is set as “Natural”, the system can auto compensate white balance to the scene
without artificial light, which is to make the image color normal.

® \When the “Mode” is set as “Street Lamp”, the system can auto compensate white balance to the
outdoor scene at night, which is to make the image color normal.

® \When the “Mode” is set as “Outdoor”, the system can auto compensate white balance to the most
outdoor scenes with natural light and artificial light, which is to make the image color normal.

® \When the “Mode” is set as “Manual’, it can manually set the value of red gain and blue gain; the
system can compensate the different color temperatures in the environment according to the
settings.

® \When the “Mode” is set as “Regional Custom”, it is to set customized area, the system can
compensate white balance to different color temperature of the images in the area, which is to
make the image color normal.

Step 3
Click “Save” to complete the config of WB mode.

5.1.1.5 Day & Night

It is to set the switch between color mode and black & white mode.

Step 1

Select “Setup > Camera > Conditions > Day & Night” and the system will display the interface of “Day &
Night”, which is shown in Figure 5-5.

IP Camera

Profile | Normal

[]

> Video

> Audio bt teaciie Mode | Auto

Network A - - D i Sensitivity| Middle

] 6] E]

Event - ~ B Packigat Delay | 6S

Storage g = » WB

» Day & Night

System

Information

» IR Light

\ Default ‘ | Refresh | | Save |

Figure 5-5
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Step 2

Set day & night parameter; please refer to the following sheet for more details.

Parameter

Note

Mode

It is to set the camera image displayed as color or black & white mode.

Note:

The setting of “Day/Night Mode” is not affected by the setting of “Profile

Management”.

It includes the following options:

® Color: The camera image is displayed as color image.

® Auto: The camera can auto select color image or black & white image
to be displayed according to the environmental brightness.

® Black & white: The camera image is displayed as black & white image.

Sensitivity

The parameter can be set when the “Day/Night Mode” is “Auto”.
It is to set the sensitivity of the switch between image color display and
black & white display.

Delay

The parameter can be set when the “Day/Night Mode” is “Auto”.

It is to set the switch delay between image color display and white & black
display. The smaller the delay is, the faster of the switch becomes between
color display and black & white display.

Step 3

Click “Save” to complete the config of day/night mode.

5.1.1.6 Defog

The image quality will become weak when the device is in the environment with fog or haze, you can

enable defog function to adjust the image definition.

Step 1

Select “Setup > Camera > Conditions > Defog” and the system will display the interface of “Defog”
which is shown in Figure 5-6.
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IP Camera

Profile Day
>

> Audio . e Mode OFF [+]
Network e P o N - » Exposure

Event S » Backlight

Storage y ] » WB

System » Day & Night

= :
. b 3

Figure 5-6

Step 2

It is to set defog mode according to the actual scene.

® \When the “Mode” is set as “Manual’, it is to manually set intensity and air light mode, the system
will adjust the image definition according to the intensity and air light mode which have been set
previously. As for air light mode, you can set manual or auto.

® When the “Mode” is set as “Auto”, the system will auto adjust the image definition according to the
actual scene.

® \When the “Mode” is set as “Off”, then the defog function is disabled.

Step 3
Click “Save” to complete the config of defog mode.

5.1.1.7 IR Light

You can directly set the mode of IR light if the device is equipped with IR light.

Step 1

Select “Setup > Camera > Conditions > IR Light” and the system will display the interface of “IR Light”
which is shown in Figure 5-7.
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IP Camera

> Video

> Audio

Network

Event

Storage
System

Information - » IR Light
. b

Step 2
Itis to set

Profile. Normal

» Picture Mode SmartiR EI
» Exposure

» Backlight

» WB

» Day & Night

el

| Default J | Refresh | ‘ Save |

Figure 5-7

IR light mode according to the actual scene.

® When the “Mode” is set as “Manual’, it can manually set the brightness of IR light; the system will
realize light compensation to the image according to the IR light intensity.
® When the “Mode” is set as “Smart IR”, the system can adjust the light brightness according to the

actua

| scene.

® When the “Mode” is set as “Zoomprio”, the system can auto adjust the IR light according to the

bright
L 4
L 4
® \When
Step 3

ness change of the actual scene.

The system will enable near light by priority when the actual scene becomes dark, the system
will enable the far light when the near light fails to meet the requirement of scene brightness
even if it is adjusted to the brightest.

The system will adjust far light brightness by priority to off and then adjust the brightness of
near light when the actual scene becomes bright. The system will always disable far light
when the focal length of the lens is adjusted to a certain wide angle, which is to avoid near

overexposure. Meanwhile, it can manually set light compensation to slightly adjust the
brightness of IR light.

the “mode” is set as “Off”, it will not enable the IR light.

Click “Save” and complete the config of IR light.

33



5.1.1.8 Profile Management

Step 1

Select “Setup > Camera > Conditions > Profile Management” and the system will display the interface of
“Profile Management”.

Step 2

Set profile management.

® When the “Profile Management” is set as “Normal”, the system will monitor according to the normal
config.

IP Camera

Conditions Profile Management Zoom and Focus

: Profile Management & Normal € Full Time ¢ Schedule
> Video

> Audio Default | | Refresh ‘ l
Network

Event
Storage
System

Information

Figure 5-8

® \When the “Profile Management” is set as “Full Time”, you can select “Always Enable” in “Day” or
“Night’, the system will monitor according to the config of “always enable”.

IP Camera

Camera Conditions Profile Management Zoom and Focus

g Profile Management € Normal  Full Time € Schedule

Always Enable Day ¥
> Audio

Network l Default I I Refresh | | Save
Event

Storage
System

Information

Figure 5-9

® When the “Profile Management” is set as “Schedule”, you can set some period as day and another
period as night, for example, if it sets 0:00~12:00 as day, 12:00~24:00 as night, then the system will
monitor by adopting corresponding config in different periods.
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IP camera

Camera Conditions

Profile Management Zoom and Focus

SR Profile Management ¢ Normal € Full Time  Schedule
fide:

> Audio

Network Perogseting  (JE = e e e e e e e e
Event 0:00 4:00 8:00 12:00 16:00 20:00 24:00
Storage EDay M Night

S | Default l | Refresh ’ | Save l

Information

Figure 5-10
Step 3
Click “Save” to complete the settings of profile management.
Note:

Click “Default” to restore the device to default config; click “Refresh” to check the latest config file of the
device.

5.1.1.9 Zoom and Focus

Note:

Only motorized vari-focal devices support focus and zoom function.

Step 1

Select “Setup > Camera > Conditions > Zoom and Focus” and the system will display the interface of
“Zoom and Focus” which is shown in Figure 5-11.

IP Camera

Camera Conditions

> Video

> Audio
Network
Event
Storage
System

Information

zoom wipE (=) [ . TELE Speed [20 ~ Restore All
Focus NEAR (=) (F - FAR  Speed [20 ~| | C+3AutoFocus Refresh

Figure 5-11

Step 2
Adjust the focal length of the lens.
After it is zoomed, set “Speed” and press “+”, “-“or drag the sliding block directly to adjust.
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Step 3

Adjust the lens definition.

After it is focused, set “Speed” and press “+”, “-“or drag the sliding block directly to adjust.

Note:

® Speed is used to set the length by pressing “+” and

® After adjusting the focal length of the lens or click “Auto Focus”, the device will auto adjust the
image definition, it is not allowed to implement other lens operation during auto focus.

® After several times of zoom and focus, the image fails to be adjusted clear, click “Restore All’ to
reset the lens to zero and remove the accumulative error of the lens.

® Click “Refresh” and the device will automatically synchronize the hardware to the location of sliding
block of lens zoom and focus.

“ o

5.1.2 Video

5.1.2.1 Video

Step 1

Select “Setup > Camera > Video > Video” and the system will display the interface of “Video” which is
shown in Figure 5-12 (Non fisheye).

IP Camera

Camera Video Snapshot Overlay Path

> Conditions

. Video Main Stream Sub Stream
Network Enable Sub Stream 2 v
Event Encode Mode H.264H v Encode Mode H.264H v
Storage Smart Codec OFF v ® Resolution D1 (704*480) v
System Resolution 2304x1296 (2304*1296 v Video Clip
Information Frame rate(FPS) 30 v Frame rate(FPS) 6 Y
Bit Rate Type CBR v Bit Rate Type CBR v
Reference BitRate  1792-10240Kb/S Reference BitRate  48-896Kb/S
Bit Rate 6144 v Bit Rate 896 v
| Frame Interval 60 (30~150) | Frame Interval 12 (6~150)

| Watermark Settings

Watermark Character | Digital CCTV

Default I | Refresh I I Save

Figure 5-12 (Non fisheye)

Step 2
Set video bit stream, please refer to the following sheet for more details about the parameters.
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Parameter

Function

Installation Mode

It will display the parameter when the device is fisheye.
There are three installation modes for fisheye which are
ceiling, wall mount and ground installation, please
select installation mode according to the actual
installation scene of the fisheye.

The system will begin to switch after switching
installation mode, it will prompt successfully saved after
it is switched successfully.

Note:

The device end will output the dewarped video stream
after configuring installation and record mode, when the
device is accessed to third-party platform, it will directly
display the dewarped image on the third-party platform.

Record Mode

It will display the parameter when the device is fisheye.

The system will begin to switch after record mode is

switched, it will prompt saved successfully after it is

switched successfully.

The record mode will change according to the different

installation modes.

® 10: the original picture which is not dewarped.

® 1P: 360°rectangular panorama.

® 2P: The mode can be set when the “Installation
Mode” is set as “Ceiling” or “Ground”. It is the 2
related 180°rectangular image, the two sub
windows can both form 360°panorama anytime.

® 10+3R: original image + 3 independent sub
images, both the sub image and sub boxes in the
original image can support zoom and movement.

® 1R: Original image + independent sub image, the
sub boxes of the original image support zoom and
movement.

® 4R: original image + 4 independent sub images,
both the sub image and sub boxes in the original
image support zoom and movement.

® 2R: Original image + 2 independent sub images,
the sub boxes of the original image can support
zoom and movement, the sub image supports up
and down movement, which can change the
vertical angle of view.

Note:

The device end will output dewarped video stream after

configuring installation and record mode, when the

device is accessed to the third-party platform, it will

directly display the dewarped image on the third-party

platform.
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Parameter

Function

Sub Stream Enable

Select “Enable” to enable sub stream.
The device supports enabling sub stream 1 and sub
stream 2 at the same time.

Smart Codec

It can enhance image compression performance and
reduce storage space by enabling intelligent encoding.
Note:

After intelligent encoding is enabled, the device will not
support third stream, ROI or intelligent event detection,
please refer to the actual interface for more details.

Encode mode

There are five options: H.264 (main profile standard,

H.264H (high profile standard), H.264B (Baseline

Profile), H.265 (main profile standard) and MIJPEG

encode.

® The H.264, H.264H both are H264 bit stream.
H.264 is the Main Profile encode and you need to
enable the sub stream function in your camera and
set the resolution as CIF. Then you can monitor via
the Blackberry cell phone.

® The H.265 is the main profile encode mode.

® MJPEG: In this encode mode, the video needs to
large bit stream to guarantee the video definition.
You can use the max bit stream value in the
recommend bit to get the better video output effect.

Resolution

There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.

Note: When video is under rotating status, you cannot
set resolution higher than 1080P (excluding 1080P).

Video Clip

The function is only supported by sub stream 2, please
refer to “Video Clip” for more details below the sheet.

Frame Rate (FPS)

PAL: 1~25f/s, 1-50f/s NTSC: 1~30f/s or 1~60f/s.
The frame rate may vary due to different resolutions.

Bit Rate Type

There are two options: VBR and CBR.
Please note, you can set video quality in VBR mode.
Under MJPEG mode, only CBR is available.

Recommended Bit

Recommended bit rate value according to the resolution
and frame rate you have set.

Bit Rate

® |n CBR, the bit rate here is the max value. In
dynamic video, system needs to low frame rate or
video quality to guarantee the value.

® The value is null in VBR mode.

® Please refer to recommend bit rate for the detailed
information.

38



Parameter Function

sSvC Frame rate can be encoded by layer. It is a flexible
encoding method. By default, itis 1 as 1 layer. You also
can set 2/3/4 layers.

| Frame Here you can set the P frame amount between two |

frames. The value ranges from 1 to 150. Default value
is 50.

Recommended value is frame rate *2.

Watermark Settings

Select “Watermark Setting” and enable watermark
function. After the watermark function is enabled, you
can check if the video is tampered via verifying
watermark character.

Watermark Character

It is the character of watermark verification; it is Digital
CCTV by default.

® Video Clip

1. Select “Sub Stream 2” in the drop-down box, click “Enable”.

2. Enable “Video Clip”, cIick‘Y"t‘: .

The system will display the interface of “Area”, which is shown in Figure 5-13.
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Resolution b1 (7047480) E| Save

Cancel

Figure 5-13

Select the needed resolution and clip the needed image on the interface, which is shown in Figure

5-15.

Click “Save”. You can check the clipped video in the preview interface (the sub stream 2 preview

interface only displays the clipped area), which is shown in Figure 5-14.
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IP Camera
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Step 3
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Figure 5-14

Click “Save” to complete video stream setup.

5.1.2.2 Snapshot

The snapshot interface is shown as in Figure 5-15.

IP Camera

Video
> Conditions

> Audio

Snapshot Type
Image Size
Quality
Network

Interval
Event
Storage

System

Snapshot

General

1080P (1920*1080)
5
18

pefaut || Reesn [ sawe

J~Il= THEHE SR X©))

Figure 5-15
Please refer to the following sheet for detailed information.
Parameter Function
Snapshot type There are two modes: general (schedule) and Event (activation).
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Image size It is the same as the resolution of main stream.

Quality Itis to set the image quality. There are six levels.

Interval It is to set snapshot frequency. Optionall~7s/picture, customized.

5.1.2.3 Video Overlay
The video overlay interface is shown as in Figure 5-16.

IP Camera

> Conditions

g O EVAYEETY] (O Enable @ Disable
) » Channel Title

> Audio

’ » Time Title

Network

Event . - I » Text Overlay

Storage ' » Picture Overlay

System 3 » Counting

Information

|_RemoveAll || Delete | (orRightclck)

| Default | | Refresh ‘ | Save

Figure 5-16

IP Camera

Snapshot
> Conditions

» Privacy Masking @ Enable () Disable

» Time Title IPC
» Text Overlay
Storage . o » Picture Overlay
System » Counting

Information




Figure 5-17

IP Camera

Snapshot
> Conditions

S L » Channel Title Week Display
wudio f

» Privacy Masking @ Enable Disable

ST - S = L o » Text Overlay

Network

Storage » Picture Overlay

System » Counting

Information

Defaut || Reesn || Save

IP Camera

20]3_10_22 14‘.3 1) » Privacy Masking (O Enable © Disable

- > » Channel Title Input Text:
> io

— » Time Title

Network 3 3 S i

Storage 4 3 » Picture Overlay

System o » Counting

Information

Text Align

Right [~]

Figure 5-19
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IP Camera

» Privacy Masking

) Enable © Disable
DL S— » Channel Title Picture Preview:

> Audio

3 | » Time Title

Network i -3 -

e i - 2 ‘-~_~ » Text Overlay

Storage ~ W » Picture Overiay

System £ 4 » Counting

Information

Upload Picture

Requirement for picture upload
1. Max size is 16k.

2. Max resolution is 128x128 pixels.
3. 256 colors, bmp format.

IP Camera

» Privacy Masking () Enable © Disable
» Channel Title Statistics Type

[V] Enter Number

> Audio e
. - | » Time Title
letwol - I = [v] Leave Number
o » Text Overlay
Event " ] Y

- i Text Ali
Storage 4 » Picture Overlay an

Left [=]

System

Information

Figure 5-21

Please refer to the following sheet for detailed information.

Parameter Function

Privacy Masking ) :i;ei%??, igig privacy mask the specified video in the
@® System max supports 4 privacy mask zones.

Time Title ) _You can_enz_able_ this fqnction so that system overlays time
information in video window.
® You can use the mouse to drag the time tile position.
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Channel Title ® You can enable this function so that system overlays
channel information in video window.

® You can use the mouse to drag the channel tile position.

® You can enable this function to overlay text in video
window.

®  Private protocol is connected to mobile NVR, support GPS
information overlay.

® You can use the mouse to drag location box to adjust its
position. Alignment include align left and align right.

® You can enable this function to display overlay picture.
Click on disable to turn it off.

® Click on Upload Picture to overlay local picture into
monitoring window. You can drag the yellow box to move
it.

Note:

You cannot enable text and picture overlay at the same time.
Counting ® Check “Enable” to display the counting statistics data in
the video monitoring window; check “Disable” not to

display.
® There are enter number and leave number for statistics
type and left align and right align for OSD info.

Text Overlay

Picture Overlay

Refresh ® Set privacy mask, channel title, time title, location, overlay
and save the change. You can click on Refresh to see
effect.

Default ® Click it to restore default config.

Save ® Click it to complete video settings.

5.1.2.4 ROI

Note: Some series don’t support ROI setup function.

IP camera T ST AT ST ST AT

Snapshot

Overlay

> Conditions

> Audio

Enable ¢ Disable

Image Quality | 6(best) v

Network
Event
Storage
System

Information

IiRemove All | [ Delete | (Or Righiclick)

l Default | I Refresh I l Save




Figure 5-22

IP Camera

Camera
> Conditions

> Audio

Network
Event
Storage
System

Information

Snapshot Overlay Path
Enable ' Disable

Image Quality |6(best) ¥

Remove All Delete {Or Rightclick )

| Default “ Refresh | I Save

Figure 5-23
Parameters | Note
Enabl Check “Enable”, then it will display the ROI in the video monitoring window;
nable
Check “Disable”, then it won’t display.
e Set the image quality of ROI, ranging from 1~6, default is 6.
Image Note:
Quality For fisheye device, it ranges from 1~6 (best), default is 6 (best)
e Able to set area block, max 4 areas.
5.1.2.5 Path

The storage path interface is shown as in Figure 5-24.

Here you can set snap image saved path and the record storage path.

® The default monitor image path is C:\Users\admin\WebDownload\LiveSnapshot.

® The default monitor record path is C:\Users\admin\WebDownload\LiveRecord.

® The default playback snapshot path is C:\Users\admin\WebDownload\PlaybackSnapshot.
The default playback download path is C:\Users\admin\WebDownload\PlaybackRecord.

The default playback cut path is: C:\Users\admin\WebDownload\VideoClips.

Note:

Admin is locally logged in PC account.
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Please click the Save button to save current setup.

IP Camera

Video Snapshot

Conditions
2 Live Snapshot C:\Users\admin\WebDownload\LiveSnapshot Browse...
I T i Live Record C:\Users\admin\WebDownload\LiveRecord Browse...
> Audio
Playback Snapshot  C:\Users\admin\WebDownload\PlaybackSnapshot Browse...
Network
Event Playback Download  C:\Users\admin\WebDownload\PlaybackRecord Browse...
ven!
Video Clips C:\Users\admin\WebDownload\VideoClips Browse...
Storage
System Default l l Save
Information

Figure 5-24

5.1.3 Audio

Please note some series devices do not support audio function.
5.1.3.1 Audio

The audio interface is shown as below. See Figure 5-25.

IP Camera

Audio

> Conditions
> Video [~ Encode
Main Stream
e [V] Enable
Event Encode Made GT711A E]
Storage Sampling Frequency | 16k EI
System
_ Sub Stream
Information
["} Enable Sub Stream 1 E|
Encode Mode G711A E]
Sampling Frequency | 16k EI
Aftribute
Audioln Type Lineln [+]
Noise Filter Enable El
Wicrophone Volume [=] 0 50
SpeakerVolume  [=] 0 50
Default | [ Refresh | I Save |

Figure 5-25

Please refer to the following sheet for detailed information.
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Parameter

Function

Enable

You can enable audio only when video is enabled.

After selecting the “Enable” of main stream or sub stream, the
network transmission stream is the audio/video composite
stream, otherwise it only includes video image.

Encode mode

The encode mode of the main stream and extra stream include
G.711A, G.711Mu, G.726 and ACC. The default mode is
G.711A.

The setup here is for audio encode mode and the bidirectional
talk encode both.

Sampling The sampling frequency of audio. It includes the following
Frequency options:
® 8K
® 16K
® 32K
® 48K
® 64K
Audioln Type Two modes to select: Lineln, Mic.
Device needs to connect external audio input source under
Lineln mode, and it doesn’t need to connect external audio
input source under Mic mode.
Noise Filter Enable the function and it can filter relevant noise.
Microphone Adjust microphone volume from 0~100.
Volume

Note:
Supported by some devices.

Speaker Volume

Adjust speaker volume from 0~100.
Note:
Supported by some devices.

5.1.3.2 Alarm audio
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IP Camera

Alarm Audio

alarm1.pem

o alarm2.pcm (]

Information

Figure 5-26
add saudio File [ X
= Record = Upload
Audio File | pcm
Fecord
Figure 5-27

Audio management currently supports PCM format to record and PCM, wav two forms to upload, and
can select an audio file for the audio alarm linkage.
The way to download the web alarm playback audio file into local is as follows:

Step 1 Use the left mouse button to click the hollow circle " in the “choice” column on the left, and

shows = , which means effective choice of alarm audio.

Step 2 Use the right mouse button to click : , select “save target as” to download.

5.2 Network

5.2.1 TCP/IP

The TCP/IP interface is shown as in Figure 5-28. It supports IPv4 and IPv6. IPv4 supports static IP
and DHCP. IPv6 supports static IP only. When users manually modify IP address, WEB wiill
automatically jump to the new IP address.
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IP camera

Camera

Network

> PPPoE
> DDNS
> IP Filter

> SMTP(Email)

> UPnP
> SNMP
> Bonjour

TCPIP

> Connection

TCP/IP

Host Name

Mode

IP Version

IP Address

> Multicast

> B02.1x

> QoS
Event
Storage

System

Information

Ethernet Card

MAC Address

Subnet mask
Default Gateway
Preferred DNS Server, 8 8

Alternate DNS Server | 8 8 4

IPC

Wire(DEFAULT) [+]
@ Static ) DHCP

1

255 . 255 0
10 15 o

8

Enable ARP/Ping to set IP address service

Defaul || Refesh |[  sawe

Figure 5-28
Please refer to the following sheet for detailed information.

Parameter Function

Host Name It is to set current host device name. It max supports 15
characters.

Ethernet Card Please select the Ethernet port. Default is wired.

Please note you can modify the default Ethernet card if there is
more than one card.

Mode There are two modes: static mode and the DHCP mode. Select
DHCP mode, it auto searches IP, and you cannot set IP/subnet
mask/gateway. Select static mode, you must manually set
IP/subnet mask/gateway.

Mac Address It is to display hose Mac address.

IP Version It is to select IP version. IPV4 or IPV6.

You can access the IP address of these two versions.
IP Address Please use the keyboard to input the corresponding number to

modify the IP address and then set the corresponding subnet
mask and the default gateway.

Preferred DNS

DNS IP address.

Alternate DNS

Alternate DNS IP address.
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Enable
ARP/Ping set
device IP
address service.

You can use ARP/Ping command to modify or set the device IP
address if you know the device MAC address.

Before the operation, please make sure the network camera
and the PC in the same LAN. This function is on by default.

You can refer to the steps listed below.

Step 1: Get an IP address. Set the network camera and the PC
in the same LAN.

Step 2: Get the physical address from the label of the network
camera.

Step 3: Go to the Run interface and then input the following
commands.

arp —s <IP Address> <MAC>

ping -l 480 —t <IP Address>

Such as: arp -s 192.168.0.125 11-40-8c-18-10-11
ping -l 480 -t 192.168.0.125

Step 4: Reboot the device.

Step 5: You can see the setup is OK if you can see there are
output information such as “Reply from 192.168.0.125 ...” from
the command output lines. Now you can close the command
line.

Step 6: Open the browse and then input http://<IP address>.
Click the Enter button, you can access now.

5.2.1.1 Easy4ip

Click “Enable” to connect the device to network, and then you can connect to the device via mobile
client of Easy4ip after “Online” is displayed on the interface (connection mode: add device serial number

or scan QR code). See Figure 5-29.

IP Camera

Camera TCP/P
] Enable

Status

> PPPoE
SIN

> DDNS

QR Code
> IPFilter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

> HTTPs
Event
Storage

System

Information

Easy4dip

Offline
1L0092EPAAD0270

Default J l Refresh I ‘ Save

Figure 5-29




5.2.2 Connection

5.2.2.1 Connection

The connection interface is shown as in Figure 5-30.

IP Camera

Camera

> TCPAP

TCP Port 37777 (1025~65534)
: >PP0E B UDP Port 37778 (1025~65534)
> DDNS HTTP Port 80
> IPFilter RTSP Port 554
> SMTP(Email) HTTPs Port 443

> UPnP
> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

> HTTPs

Event

Storage

System
Information

Connection

Max Connection (1~20)

Default | | Refresh l l Save

Figure 5-30
Please refer to the following sheet for detailed information.
Parameter | Function
Max It is the max Web connection for the same device. The value ranges from 1
connection | to 20. Default connection amount is 10.
TCP port Port range is 1025~65534. The default value is 37777. You can input the
actual port number if necessary.
UDP port | Portrange is 1025~65534. The default value is 37778. You can input the
actual port number if necessary.
HTTP port | Port range is 1025~65524. The default value is 80. You can input the
actual port number if necessary.
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RTSP port | ® The default value is 554. Please leave blank if use default. User uses
QuickTime or VLC can play the following formats. BlackBerry can play
too.

® Real-time monitoring URL format, please require real-time RTSP
media server, require channel no., bit stream type in URL. You may
need username and password.

® User uses BlackBerry need to set encode mode to H.264B, resolution
to CIF and turn off audio.

URL format is:
rtsp://lusername:password@ip:port/cam/realmonitor?channel=1&subtype=0
Username/password/IP and port.

The IP is device IP and the port default value is 554. You can leave it in
blank if it is the default value.

Follow standard RTP protocol and when encode mode is MJPEG, the max
resolution only supports 2040*2040.

HTTPs HTTPs communication port, range is 1025~65534, default is 443.
Port

Note:

® (0~1024, 37780~37880, 1900, 3800, 5000, 5050, 9999, 37776, 39999, 42323 are all special ports.
User cannot modify them.

® Avoid using default port value of other ports.

5.2.2.2 ONVIF

ONVIF (Open Network Video Interface Forum) , this standard describes network video mode,
interface, data type and data interaction mode. ONVIF Standard’s aim is to achieve a network video
frame agreement and makes the network video products (including video front-end, video equipment,
etc.) from different manufacturers completely compatible.

ONVIF function is on by default.
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IP Camera

Camera Connection ONVIF

> TCPIP Authentication @ ON (©) OFF

Default ‘ | Refresh | \ Save

> PPPOE

> DDNS
> IP Filter
> SMTP(Email)
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

> HTTPs
Event
Storage
System

Information

Figure 5-31

5.2.3 PPPoOE

The PPPOE interface is shown as in Figure 5-32.

Enter the PPPoE username and password which are provided by ISP (Internet Service Provider), and
click “Enable”. The network camera will automatically establish network connection in the mode of
PPPOE after it is enabled; after it is successful, the IP of the “IP Address” will be automatically modified
into the dynamic IP address of the acquired WAN.

Note:

After PPPOE dial-up is successful, it needs to log in the device via the IP which is set before dial-up; in
the PPPOE setup interface, it will display the registered IP address, and then it can visit the IP address
via client.

Please disable UPnP when clicking PPPoE enable, which is to avoid causing influence to PPPoE dial-
up.

IP camera

Camera PPPoE

[] Enable
> TCPIP
Usemame
> Connection

e
> DDNS
> IP Filter
> SMTP(Emai)
> UPnP
> SNMP

> Bonjour
> Multicast
> B021x
> QoS
Event

Storage

System

Information

Figure 5-32
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5.2.4 DDNS

The DDNS interface is shown as in Figure 5-33.

The DDNS is to set to connect the various servers so that you can access the system via the server.
Please go to the corresponding service website to apply a domain name and then access the system
via the domain. It works even your IP address has changed. When the device connects to WLAN, you
should disable UPnP.

IP Camera

Camera DDNS

™ Server Type QUICK DDNS =

Server Address www._quickddns.com
> Connection

Mode ® o manual
> PPPOE

m Domain Name 9002A91CCOCE quickddns com

> IP Filter Username (Optional)Please input the mailbox

> SWTP(Email) peait || Rewesn ][ saw

> UPnP

> SNMP
> Bonjour
> Multicast
> WIFI

> 802.1x
> QoS
Event
Storage

System

Information

Figure 5-33

Please refer to the following sheet for detailed information.

Parameter Function

Server Type Click it to select DDNS protocol type, which includes: CN99
DDNS, NO-IP DDNS, Dyndns DDNS, Quick DDNS, the default is
Quick DDNS.

Server Address | DDNS server IP address

CN99 DDNS

Server address: www.3322.0rg

NO-IP DDNS

Server address: dynupdate.no-ip.com
Dyndns DDNS

Server address: members.dyndns.org
Dahua DDNS

Server address: www.dahuaddns.com

Mode Default is auto, able to choose manual
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Parameter Function

Domain Name | Both auto and manual are “MAC addresss.quickddns.com” by
default, it is able to set prefix manually.

Username The user name you input to log in the server, optional.

The CN99 DDNS interface is shown as in Figure 5-34.

IP camera

Camera DDNS

Network

[[] Server Type CN99 DDNS (=]
> TCPIP

Server Address

> Connection

Domain Name none
> PPPoE

> IP Filter
> SMTP(Emal) Update Pericd 10 Minute (1~500)

Usemname none

Password sose

2 e Defauit H Refresh H

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

Event

Storage

System

Information

Figure 5-34

Parameter Function

Server Type You can select CN99 DDNS protocol

Server Address | Under CN99 DDNS the default server address is “www.3322.0org”

Domain Name Self-defined domain name

Username The user name you input to log in the server.

Password The password you input to log in the server

The refresh period of the connection between the device IP and the server, default

Refresh Period | 1016 minutes.

5.2.5 1P filter

The IP filter interface is shown as in Figure 5-35.

You can enable IP filter function so that some specified IP/MAC user can access the network camera.
You can add IP address or IP segment.

If you do not check the box here, it means there is on access limit.
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Here you can add IP address and MAC address. You must add these addresses before enabling the

trusted sites.

Please note: You must set MAC address in the same network segment.

IP camera

Camera

> TCPiIP

> Connection
> PPPoE

> DDNS

> SMTP(Email)
> UPnP

> SNMP

> Bonjour
> Muliicast
> 802.1x
> QoS
Event

Storage

System

Information

IP Filter

Trusted Sites
Trusted Sites

IP address IMAC address

Modify

Delete

5.2.6 SMTP (e-mail)

The SMTP interface is shown

IP camera

Camera

> TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter
SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

Event

Storage

System

Information

SMTP(Email)

SMTP Server
Port

[ Anonymity
Usemame
Password

Sender

Authentication
Title

Mail Receiver

Interval

[7] Health Mail

Figure 5-35

as in Figure 5-36.

none

25
anonymity
seee
none
None [+]
IPC Message Attachment
+
0 Second (0~3600)
Update Period Second (1~3600)
| oefamn || Refesn || sawe

Figure 5-36

Please refer to the following sheet for detailed information.
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Parameter

Function

SMTP Server

Input server address and then enable this function.

Port Default value is 25. You can modify it if necessary.

Anonymity For the server which supports the anonymity email function, it
won'’t display the information of the sender.

User Name The user name of the sender email account.

Password The password of sender email account.

Sender Sender email address.

Authentication You can select SSL, TLS or none.

(Encryption

mode)

Title (Subject)

Input email subject here.

System can send out the email of the snapshot picture once

Attachment
you check the box here.

Mail receiver Input receiver email address here. Max three addresses.

Interval The send interval ranges from 0 to 3600 seconds. 0 means
there is no interval.
Please note system will not send out the email immediately
when the alarm occurs. When the alarm, motion detection or
the abnormity event activates the email, system sends out the
email according to the interval you specified here. This
function is very useful when there are too many emails
activated by the abnormity events, which may result in heavy
load for the email server.

Health mail Please check the box here to enable this function.

enable

Email test The system will automatically sent out a email once to test the
connection is OK or not .Before the email test, please save
the email setup information.

5.2.7 UPnP

It allows you to establish the mapping relationship between the LAN and the public network.

Here you can also add, modify or remove UPnP item. For UPnP on different routers, you must disable
UPnNP function. See Figure 5-37.

In the Windows OS, From Start->Control Panel->Add or remove programs. Click the “Add/Remove
Windows Components” and then select the “Network Services” from the Windows Components Wizard.
Click the Details button and then check the “Internet Gateway Device Discovery and Control client” and
“UPnP User Interface”. Please click OK to begin installation.
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Enable UPnP from the Web. If your UPnP is enabled in the Windows OS, the network camera can auto

detect it via the “My Network Places”.

Under manual mode, you can modify external port. Under auto mode, select idle port for auto port
mapping without user modification.

IP Camera

Camera

> TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
[ vee |

> SNMP

> Bonjour

» Multicast

» B02.1x

> QoS

Event

Storage

System

Information

5.2.8 SNMP

UPnP

[F] Enable

Port Mapping List

E EEE

Mode Manual [~]

WebService
PrivService
PrivService

RTSPService

Router State Mapping Failed

WebService TCP 80 8080 Mapping Failed ki
PrivService:-TCP 37777 77T Mapping Failed

PrivService:UDP 37778 37778 Mapping Failed

RTSPService: TCP 554 554 Mapping Failed

Figure 5-37

The SNMP interface is shown as in Figure 5-38 and Figure 5-39.

The SNMP allows the communication between the network management work station software and the
proxy of the managed device. Please install the software such as MG MibBrowser 8.0c software or
establish the SNMP service before you use this function. You need to reboot the device to activate the

new setup.
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IP camera

Camera SNMP

Network

SNMP Version
> TCPIP

> Connection SNMP Port
> PPPoE Read Community
> DDNS Write Community

> IP Filter Trap Address
> SMTP(Email)

> UPnP

SNMP

> Bonjour

Trap Port

> Multicast
> 802.1x
> QoS
Event

Storage

System

Information

[] SNMP w1 [T] SNMPv2 [7] SNMP v3

161 (1~65535)
public

private

162

Defaut || Refesh || Save

Figure 5-38

Please refer to the following sheet for detailed information.

Parameter

Function

SNMP Version

® Check SNMP v1, device only process vl info.
® Check SNMP v2, device only process V2 info.

® Check SNMP v3, can set username, password and
encryption method. Server calibrate corresponding
username, password and encryption method too access
device and v1/v2 are unavailable.

SNMP port

The listening port of the proxy program of the device. Itis a
UDP port not a TCP port. The value ranges from 1 to 65535.
The default value is 161

Community

It is a string, as command between management and proxy, ,
defining a proxy, and a manager’s authentication.

Read community

Read-only access to all SNMP targets, default is public.
Note: Only number, letter, , and — supported.

Write community

Read/write access to all SNMP targets, default is private.
Note: Only number, letter, , and — supported.

Trap address

The destination address of the Trap information from the
proxy program of the device.

Trap Address

Address where to send Trap message.

Trap Port

Port which send Trap message, default is 162, range
1~65535.
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IP Camera

Camera SNMP
N x
> TCPIP

SNMP Version

SNMP v1 SNMP v2 SNMP 3

> Connection SNMP Port 161 (1~65535)
> PPPoE Read Community public
> DDNS Write Community private
> IP Filter Trap Address
> SMTP(Emaily Tl 162
> UPnP

SNMP Read-only Username public
> Bonjour Authentication Type @ MD5 (O SHA
> Multicast Authentication Password
> 802.1x Encryption Type @ CBC-DES
> QoS Encryption Password
Event
Storage Read&write Usemame private
System Authentication Type @ MD5 () SHA
Information Authentication Password

Encryption Type @ CBC-DES

Encryption Password

Default ‘ | Refresh | ‘ Save

Figure 5-39

Check SNMP v3 version and SNMP port, read community, write community, Trap address, Trap port
are same with SNMP v1 and SNMP v2 versions. Only when SNMP version is SNMP v3, users need to
configure parameter in chart.

Parameter Function

SNMP Version | SNMP v3

Default is public.

Read-only _
Username Note:

Name only can be number, letter and underline.
Read/Write Defa.ult is private.

Note:
Username

Name only can be number, letter and underline.

Authentication | You may select MD5 or SHA, default is MD5.

Authentication Password not less than 8 characters.
Password

Encryption Default is CBC-DES.

Encryption Password not less than 8 characters.
Password

5.2.9 Bonjour
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The Bonjour interface is shown as below. See Figure 5-40.

Bonjour is based on the multicast DNS service from the Apple. The Bonjour device can automatically
broadcast its service information and listen to the service information from other device.

You can use the browse of the Bonjour service in the same LAN to search the network camera device
and then access if you do not know the network camera information such as IP address.

You can view the server name when the network camera is detected by the Bonjour. Please note the
safari browse support this function. Click the “Display All Bookmarks: and open the Bonjour, system can
auto detect the network camera of the Bonjour function in the LAN.

IP Camera

Camera Bonjour
Network
Enable
> TCPAP
> Connection

> PPPoE Default

Server Name YZCAEZ0ODBWOD019

> DDNS
> IP Filter
> SMTP(Email)
> UPnP
p
Bonjour
> Multicast
> 802.1x
> QoS
Event
Storage
System

Information

Figure 5-40

5.2.10 Multicast

The multicast interface is shown as in Figure 5-41.

Multicast is a transmission mode of data packet. When there is multiple-host to receive the same data

packet, multiple-cast is the best option to reduce the broad width and the CPU load. The source host

can just send out one data to transit. This function also depends on the relationship of the group

member and group of the outer.

Note

® Open preview, streaming media protocol, select multicast, and monitor via multicast format.

® Here you can set multicast address and port. You also need to go to Live interface to set the
protocol as Multicast.

62



IP Camera

Camera Multicast

N ork Main Stream Sub Stream
TCPP
2 Enable Enable Sub Stream 1 [E2
> Connection B
Multicast Address 224 1 2 . 4 |(22400.0~239.255255255) Multicast Address 224 1 2 4 | (224.0.0.0~239 255 255 255)
> PPPoE
Port 40000 (1025~66534) Port 40002 (1025~65534)
> DDNS
> IPFilter
5 SMTP(Email) Defautt || Refiesn || saw
» UPnP

> SNMP
> Bonjour
> 8021x
> QoS

Event

Storage

System

Information

Figure 5-41

Please refer to the following sheet for detailed information.

Parameter Function

Enable Select to enable multicast function. Main stream and sub stream cannot be
used at the same time.

Multicast address Main/sub stream multicast default address is 224.1.2.4 and its range is
224.0.0.0~239.255.255.255.

Port Multicast port. Main stream is 40000, sub streaml is 40016,sub stream?2 is
40032 and the range is 1025~65534.

5.2.114G

Note: This function is only for series with 4G module.

4G is a mobile communication system which makes wireless communication integrates with Internet
and multimedia communication.

5.2.11.1 Dialing Setting
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IP Camera

Camera

> nP

> Connection
> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> Bonjour

> Multicast

> QoS

Event
Storage

System

Information

Dialing Setting | Mobile Settings

Wireless Net Type Auto El [v] Enable
APN 3gnet
Authorize Mode No E|
Dial-up Number *99%
Username
Password
Update Period 30 Eerogd
Time Range
Wireless Network State
IP Address
Wireless Signal WCDMA 0%
FDD-LTE =] 70%
pefaut|[ Reesn ][ sae
Figure 5-42
Parameter Function

Wireless Net Type

Auto, WCDMA, FDD-LTE optional, you can select according
to the operator.

Enable

Check to enable 4G module.

APN

It shall be acquired from the operator according to the setup
of operator.

Authentication Mode

Auto, PAP and CHAP, the authentication algorithm is
different according to different operators.

Dial-up Number

The number is different according to different operator, it can
be acquired from operator.

User name

It shall be acquired from the operator.

Password

It shall be acquired from the operator.

Update Period

It is the period beyond the dial-up period which has been
set, it is 30s by default, which means the device can auto
acquire 4G dial-up status, cut off dial-up to save flow.

Time Range It is the time period to set dial-up. It can activate the function
via message to enable/disable dial-up function if it is
beyond the time period.

IP Address It will display the acquired IP after the dial-up is successful

via 4G.
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5.2.11.2 Mobile Setting

IP Camera

Camera Dialing Setting

> TCPAP
> Connection Receiver
> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> Bonjour

> Multicast

> QoS

Event

Title

Storage

System

Information

Mobile Settings

[7] Message Send

[7] Message Activation ] Phone Activation

Sender + Caller +

Event Message

Default | | Refresh ] [ Save

Figure 5-43

Please refer to the following sheet for detailed information.

Parameter

Function

Message Send

In the event, after the corresponding message activation is
enabled, it will send message to the phone of receiver when
event happens. It needs to enable the function of message
activation function in the event interface when using the
function.

Message
Activation

It can send message ON/OFF to the SIM card inside the device by
the mobile phone in the list, which is to enable /disable the dial-up
function and send REBOOT to restart the device.

Phone Activation

You can use the mobile phone in the calling list to call the SIM card
inside the device to enable dial-up function.

5.2.12 WIFI
Note:

Some series devices don’'t support WIFI and WPS function.
WPS function is supported by the devices with WPS button.

5.2.12.1 WIFI
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WIFI info can show the name, status, IP information of the Current Hot Spot. Usually please “Refresh”
WIFI work information after reconnection to ensure the real-time display of the work status, because it
often takes some time to connect WIFI Hot Spot, which depends on the network signal strength.

IP Camera

Camera WIFI

I” Enable

> TCPAP

1D List

> Connection

> PPPOE S
> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

ST

> 802.1x Current Hot Spot
> QoS IP address

Event Subnetmask
Default Gateway

Storage

System

Information

Figure 5-44

WIFI setting method is as follows:

¥ Enable
Step 1 Click M= , show as , means enabling WIFI function.

Step 2 Click “ Search SSID”, and shows the wireless network hot spot of the current network camera
environment in the list.
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IP Camera

Camera

> TCPAP

> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast
ET

> 802.1x

> QoS

Event

Storage

System

Information

Step 3 Click “Add SSID” when need to add a wireless network manually pop out an interface in

WIFI

¥ Enable

12345
5370test
TP-LINK_465EF6
AndroidAP
TP-LINK_425796
NETGEARG4

TP-LINK_NIJIAN

Add SSID

|| ssarenssip_|

WPA-PSK-AES
WPAWPA2-PSK-TKIP+AES
WPA-PSK-TKIP+AES

NPA2-PSK-AES
WPAWPA2-PSK-TKIP+AES
NONE
WPAIWPA2-PSK-TKIP+AES

WIFIINFO

Current Hot Spot  unconnected
IP address

Subnetmask

Default Gateway

Figure 5-45

the figure below, and enter network ID in the dialog box.

Add Wireless SSID

SSID

Ok

Cancel

B

Step 4 Double click on one can pop out the signal intensity and authentication of the hot spot.

Figure 5-46

+ Please enter the password if necessary. Please keep the choice of password index number
same as the router when entering password.

* Please click “connect’ if it is unnecessary to enter the password.

5.2.12.2 WPS
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IP camera

Camera WIFI
N ork
 Enter PIN
> TCPAP
PIN:
> Connection
SSID
> PPPOE

~
> DDNS Bution

> IP Filter Status disconnected

> SMTP(Email) connecting.__| [ Refresh

> UPnP

> SNMP

> Bonjour

> Multicast
WIFI

> 802.1x

> QoS

Event

Storage

System

Information

Figure 5-47

PIN Number and SSID are both acquired from the router, please “refresh” the work information of WIFI
to ensure the real-time display of work state after filling in correctly.

5.2.13802.1x

802.1x (port based network access control protocol) supports manual selection of authentication
method to control if device connected to LAN can join the LAN. It well supports authentication, charging,
safety and management requirement of network.

IP Camera

Camera 802.1x
Network

> TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

[C] Enable
Authentication
Usemame

Password

> Bonjour
> Multicast
> QoS
Event

Storage

System

Information

Figure 5-48

Please refer to the following sheet for detailed information.
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Parameter Function

Authentication | PEAP (protected EAP protocol).

Username It needs the username to login, which is authenticated by the
server.
Password Please input password here.
5.2.14 QoS

The QoS interface is shown as below. See Figure 5-49.

Qos (Quality of Service) is network security mechanism. It is a technology to fix the network delay and
jam problem and etc. For the network service, the quality of service includes the transmission bandwidth,
delay, the packet loss and etc. We can guarantee the transmission bandwidth, lower the delay, and
reduce the loss of the data packet and anti-dither to enhance the quality.

We can set the DSCP (Differentiated Services Code Point) of the IP to distinguish the data packet so
that the router or the hub can provide different services for various data packets. It can select the
different queues according to the priority (64 different priority levels) of the packets and select the
bandwidth of the each queue. Level O is the lowest, and level 63 is the highest. It can also discard at the
different ratio when the broad bandwidth is jam.

IP camera

Camera QoS
Network

> TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

Realtime Monitor

Command

> Bonjour
> Multicast
> 802.1x
[ oo
Event
Storage
System

Information

Figure 5-49
Please refer to the following sheet for detailed information.
Parameter Function
Real-time The value ranges from 0 to 63. The router or the switcher can
monitor provide different service for various data packets.
Command The value ranges from 0 to 63. The router or the switcher can
provide different service for various data packets.
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Parameter

Function

Enable
Wireles

Check it to enable QoS.
s QoS

5.2.15HTTPs

In the HTTPs setting interface, users can make PC log in normally via HTTPs by creating certificate or
uploading signed certificate, which is to guarantee the security of communication data and provide
safeguard for user information and device security with reliable and stable technical means.

Step 1

Create certificate or upload the signed certificate.

® Please refer to the following steps if you select “Create Certificate”.

1. Select “Setup > Network > HTTPs”, and the system will display the interface of HTTPs, which is
shown in Figure 5-50.

IP Camera

Camera

> TCPIP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS
Event
Storage

System

Information

[T] Enable HTTPs

Create Certificate

Request Created

Request Created | |

| | Download

Install Signed Certificate

Certificate Path Browse...

Cerificate Key Path Browse... I

Certificate Installed

Certificate Installed

I

Attribute

Refresh | | Save

Figure 5-50

2. Click “Create” and it will pop out the dialog box of “HTTPs”, which is shown in Figure 5-51.
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HTTPs (X
Country CN *e.g.CN
IP or Domain name | 10.15.15.211| :
Validity Period 365 Day*Range :1-5000
Province ‘none
Location none
Organization ‘none
Organization Unit none
Email
Creat Cancel
Figure 5-51

3. Fillin corresponding “Country”, “Province” and some other information; click “Create” after filling in.
It will show the prompt of “Create Successfully”, which means the server certificate has been
successfully created.

Note:

Make sure the “IP or domain name” is the same as that of the device.

4. Click “Install” and it will install the certificate on the device end, which is shown in Figure 5-52.
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IP Camera

Camera

[T] Enable HTTPs

> TCPAP

> Connection Create Certificate
> DDNS Request Created
> IPFilter
Request Created Delete | | ] I I Download
> SMTP(Email)
Install Signed Certificate

> UPnP
> SNMP Certificate Path
> Bonjour Certificate Key Path : | 2 |
> Multicast Certificate Installed
P Cerfficate Installed /7= - - -

2953 Attribute Issue to: HAP=10.15.15.211; C=CN; ST=none; o

m L=none; O=none; OU=none; EM=; (o
Event Issuer: HAP=test, C=CN; ST=test, L=test, O=test,  ~
Storage Refresh | | Save

System

Information

Figure 5-52

Click “Download”. It will pop out the dialog box of “Save as”, save the file into the computer.

€ Save As — ) ]

@VQVL‘; > Librjries » v l &,‘ arch Libraries o) |
- @

Organize ¥
M Destrop — Libraries
B Downloads = Open a library to see your files and arrange them by folder,...
/= Recent Places 3
— &| Documents
4 ;{:‘iLibraries > Library
b |¢| Documents
> J7 Music = I’ Music
b [&=] Pictures ~~7 Libeary
B Videos
s Pictures
i Library
4 /M Computer =
> & Local Disk (C:) Videos
I = DISK1_VOL2 (D) Library
» s DISK1_VOLS3 (E:) i
File name: RootCert.cer v
Save as type: | (*.cer) v]

| sawve || cance |

“« Hide Folders
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Figure 5-53

6. Double click the downloaded icon of “RootCert.cer”. The system will display the information
interface of “Certificate”, which is shown in Figure 5-55.

Certificate ﬂ

General | Details | Certification Path |

@g Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: test

Issued by: test

Valid from 2016/ 7/ 8 to 2020/ 7/ 7

[Install Cerﬁﬁcate...] Issuer Statement

[ ox ]

Figure 5-54

7. Click “Install Certificate” and it will pop out the interface of “Certificate Import Wizard”, which is
shown in Figure 5-55.
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Certificate Import Wizard &

Welcome to the Certificate Import
Wizard

This wizard helps you copy certificates, certificate trust
lists, and certificate revocation lists from your disk to a
certificate store.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept.

To continue, dick Next.

< Back [ Next > ] [ Cancel

Figure 5-55

8. Click “Next”. Select “Trusted Root Certification Authorities”, which is shown in Figure 5-56.
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contese o v
e

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
@) Place all certificates in the following store

Certificate store:
Trusted Root Certification Authorities Browse..,

Learn more about certificate stores

i s

Figure 5-56

9. Click “Next”. The system will display the interface of “Completing the Certificate Import Wizard”,
which is shown in Figure 5-57.



Completing the Certificate Import
Wizard

The certificate will be imported after you dick Finish.

You have spedified the following settings:

o8 (et B 0 e BT S Trusted Root Certifice
Content Certificate
4 UL} r

[ <Bak || Fmsh | | Concel

]

Figure 5-57

10. Click “Finish”, and it will pop out the dialog box of “Security Warning”, which is shown in Figure 5-58.
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Secvuﬁty Warning

You are about to install a certificate from a certification authority (CA)
J.\ claiming to represent:

test

Windows cannot validate that the certificate is actually from "test". You
should confirm its origin by contacting "test". The following number
will assist you in this process:

Thumbprint (shal): 6D811FD2 E82313A8 663514ED 2CA36EGB 7D425FA6

Warning:

If you install this root certificate, Windows will automatically trust any
certificate issued by this CA. Installing a certificate with an unconfirmed
thumbprint is a security risk. If you click "Yes" you acknowledge this
risk.

Do you want te install this certificate?

Yes No

Figure 5-58

11. Click “Yes”. It will pop out the dialog box of “Import Successful”, click “Ok” to complete downloading

certificate, which is shown in Figure 5-59.

B 3 N
Certificate Import Wizard @

| The import was successful.

Figure 5-59

® Please refer to the following steps if you select “Install Signed Certificate”.

1. Select “Setup > Network > HTTPs”. The system will display the interface of HTTPs, which is shown

in Figure 5-60.
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IP camera

Camera

> TCPIP [C] Enable HTTPs

> Connection Create Certificate
> DDNS Request Created
> IP Filter
Request Created I | I l Download

> SMTP(Email)

Install Signed Certificate
> UPnP
> SNMP Certificate Path Browse...
S {Ponioir Certificate Key Path Browse.. ][ Upoas |
> Multicast Certificate Installed
ORIz Cerificate Installed l:’

2a00% Attribute

Event

Storage

Refresh | | Save

System

Information

Figure 5-60

2. Select signed certificate and certificate key path respectively via “Browse”, click “Upload”.

3. Install root certificate, please refer to step 6~11 for more detalils.

4. Check “Enable HTTPs”, click “Save”. The system will display the dialog box of “Need to reboot the
device”, and then the config is valid.

Reboot

ﬂ The configuration takes effect, the device is restarting now, please don't leave this page or close the browser...

Figure 5-61

5. Use HTTPs

Use HTTPs to log in.

Enter https://xx.xx.xx.xx in the browser, and it will pop out normal login interface; the browser will prompt
certificate error if the certificate is not installed, which is shown in Figure 5-62.
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https://xx.xx.xx.xx/

ol &) - ] http=//101515.211/

N e

File Edit View Favorites Tools Help

% Favorites | 5k [B @M v ) MTTHEAE v

‘ /& Certificate Error: Navigation Blocked \ ‘

[@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
server,

We recommend that you close this webpage and do not continue to this website.
@ Click here to dose this webpage.

'i;" Continue to this website (not recommended).

® More information

Figure 5-62

Note:
“xx.xx.xx.xx” is corresponding to your IP or domain name.

5.3 Event

5.3.1 Video detection

5.3.1.1 Motion Detection

Step 1

Select “Setup > Event > Video Detection > Motion Detection’ and the system will display the interface of
“Motion Detection” which is shown in Figure 5-63.
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IP Camera

Camera Scene Changing

Network

[T] Enable
. | Working Period
> Audio Detection
Anti-Dither 5 Second (0~100)

> Smart Plan
e

> Face Detection

V] Record

> People Counting Record Delay 10 Second (10~300)
> HeatMap [¥] Relay-out
> Alarm Alarm Delay 10 Second (10~300)
> Abnormality o

"] Send Email
Storage e

[7] snapshot
System
Information Defautt__ || Remesn ][ saw

Figure 5-63
Step 2

Select “Enable” to enable motion detection function.
Step 3

Set motion detection area.

80



1. Click “Setup” and the system will pop out the interface of “Setting Area”, which is shown in Figure
5-64

Area 3
Region £l [

Name ( Region1 ‘

Sensitivity (=) ————{}——(3) 60
Threshold (5 {}———(@ 5

Figure 5-64

2. Setarea name, itis to set valid area of motion detection according to the actual situation, and it can
set the value of sensitivity and threshold respectively.
The bigger the sensitivity is, the easier it is to generate motion detection, the smaller the threshold is,
the easier it is to generate motion detection; the entire video image is the valid area of motion
detection by default.

Note:

® Different colors represent different areas; each area can set different detection area.

® The red line in the Oscillogram means triggering motion detection; green line means not triggering
motion detection.

3. Click “Save” to complete area setting.

Step 4

It is to set other parameters of motion detection, please refer to the following sheet for more details.
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Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

Click “Setup” and the system will pop out the interface of “Working

Period”.

2. ltis to set working period according to the following methods:

® Press the left mouse button and drag it on the setup interface to set.

® Click"

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

=

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from 0Os to 100s.

Area

1. Click “Setup” and the system will pop out the interface of “Set Area”.

2. Setthe area name, it is to set the valid area of motion detection
according to the actual situation, and it can set its sensitivity and
threshold respectively. The higher the sensitivity is, the easier it is to
trigger motion detect, the smaller the area threshold is, the easier it is
to generate motion detect, the whole video image is the valid area of
the motion detect by default.

Note:

Different colors represent different areas; each area can set different

detection areas.

The red line in the Oscillogram means triggering motion detect, the green

line means not triggering motion detect.

3. Click “Save” to complete area setup.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can sgnd out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm audio file when alarm occurs. Use

can set the recorded or uploaded audio file in “camera setting > audio >
alarm audio”.

Flash linkage

Check it and the flash will be on when alarm occurs, and the flash will

be off until the end of alarm after corresponding delay.
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Parameter Function
PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
® The event type includes: preset, tour and pattern.
Snapshot You need to check the box here so that system can backup motion detectior
snapshot file. You shall set snapshot period in Storage>Schedule.
Step 5

Click “Save” to complete the setting of motion detection.

5.3.1.2 Video Tampering

Step 1

Select “Setup > Event > Video Detection > Video Tampering” and the system will display the interface of

“Video Tampering” w

IP Camera

Camera Motion

> Audio Detection

> SmartPlan v
> Vs

> Face Detection 7l
> People Counting
> HeatMap m
> Alarm :‘

> Abnormality

hich is shown in Figure 5-65.

Detection JVideo Tampering]| Scene Changing

Enable Video Tampering [ Enable Defocus Detection

Working Period

Record

Record Delay 10 Second (10~300)

Relay-out

Alarm Delay 10 Second (10~300)
Send Email

Snapshot

Storage

Default | [ Refresh | | Save

System

Information

Figure 5-65
Step 2
Set the parameter of video tampering; please refer to the following sheet for more details.
Parameter Function
Enable video You need to check the box to enable video mask detection alarm.
tampering

Enable defocus
detection

You need to check the box to enable defocus detection alarm.
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Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Check it and so when alarm occurs, system will auto record. You shall set

record period in Storage>Schedule and select auto record in record control

interface.

Working Period

Record

Record Delay System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

System can delay the alarm output for specified time after alarm ended. The

Alarm Delay
value ranges from 10s to 300s.
Send Email If you enabled this function, System can gend out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Audio linkage Check it and the system will play alarm audio file when alarm occurs. Use

can set the recorded or uploaded audio file in “camera setting > audio >

alarm audio”.

Check it and the flash will be on when alarm occurs, and the flash will

be off until the end of alarm after corresponding delay.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

You need to check the box here so that system can backup motion detectior

snhapshot file. You shall set snapshot period in Storage>Schedule.

Flash linkage

Snapshot

Step 3
Click “Save” to complete the setup of video tampering.

5.3.1.3 Scene Changing

Step 1

Select “Setup > Event > Video Detection > Scene Changing” and the system will display the interface of
“Scene Changing” which is shown in Figure 5-66.
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IP Camera

Camera
Network

Event
> Audio Detection
> Smart Plan
> Ivs
> Face Detection
> People Counting
> HeatMap
> Alarm

> Abnormality

Motion Detection | Video Tampering | Scene Changing

[”] Enable
Working Period

[v] Record

Record Delay 10
V] Relay-out

Alarm Delay 10
[} send Email

"] Snapshot

Second (10~300)

Second (10~300)

Storage

Default | |

Refresh ‘ | Save

System

Information

Step 2

Figure 5-66

Check “Enable” to enable the function of scene changing.

Step 3

It is to set the parameters of scene changing, please refer to the following sheet for more details.

Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended. The

value ranges from 10s to 300s.
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Parameter Function

Send Email If you enabled this function, System can sgnd out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to

preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

Snapshot You need to check the box here so that system can backup motion detectior
snapshot file. You shall set snapshot period in Storage>Schedule.

Step 4

Click “Save” to complete the setup of scene changing.

5.3.2 Audio Detection

Step 1

Select “Setup > Event > Audio Detection” and the system will display the interface of “Audio Detection”
which is shown in Figure 5-67.

IP Camera

Camera Audio Detection

Network

> Video Detection
__ pudio Dstection
> SmartPlan

> Vs

> Face Detection
> People Counting
> HeatMap

> Alarm

> Abnormality
Storage

System

Information

[T] Enable Input Abnormal

[”] Enable Intensity Change
Sensitivity = O 50
Threshold = 0 50

Working Period

Anti-Dither 5 Second (0~100)

V] Record

Record Delay 10 Second (10~300)
[¥] Relay-out

Alarm Delay 10 Second (10~300)
[] Send Email

[”] Snapshot

Default I l Refresh | l Save

Step 2

Figure 5-67

It is to set the parameters of audio detect, please refer to the following sheet for more details.
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Parameter

Function

Enable input
abnormal

Select “Enable Input Abnormal” and it will trigger alarm when it detects
audio input abnormity.

Enable intensity
change

Select “Enable Intensity Change” and it will trigger alarm when it detects
that audio intensity change exceeds the threshold.

Sensitivity It can be judged as audio abnormity when the input volume change
exceeds continuous environment volume; users need to adjust according
to the actual environment test.

Threshold It is to set the filtered environment volume intensity, if the environmental

noise is too big, then the value needs to be set higher, users can adjust
according to the actual environment test.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from Os to 100s.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can sgnd out err_1ai| to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to

preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

Snapshot You need to check the box here so that system can backup motion detectior

snapshot file. You shall set snapshot period in Storage>Schedule.
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Step 3
Click “Save” to complete the setup of audio detection.

5.3.3 Smart Plan
Smart plan is the master switch for intelligent analysis such as “Face Detection”, “Heat Map”, “IVS”,

“People Counting” and so on, the corresponding intelligent functions can be valid after smart plan is
enabled.

Step 1

Select “Setup > Event > Smart Plan”. The system will display the interface of “Smart Plan”, which is

shown in Figure 5-68.

IP Camera

Camera Smart Plan

Network

> Video Detection
> Audio Detection

> Stereo

> People Counting

> Face Detection Refresh

> HeatMap
> Alarm

> Abnormality
Storage
System

Information

Figure 5-68

Step 2
Click “Save” to complete the config of smart plan.

5.3.4 Stereo
Note
The precondition is to select “Setup > Event > Smart Plan” and enable the master switch of

corresponding intelligent analytics.
It is used for stand detection; it can detect object and people with certain height.

5.3.4.1 Rule Config



It is to configure the rule of stand detection. It will trigger alarm when the object or people reach certain

height.
Step 1

Select “Setup > Event > Stereo” and the system will display the interface of “Rule Config”, which is

shown in Figure 5-69.

IP Camera

Camera

Network

> Video Detection
> Audio Detection

> SmartPlan

> People Counting
> Face Detection

> HeatMap

> Alarm

> Abnormality

Storage

System

Information

Rule Config Calibration Config

Rule Stand Detection [~ [C] Enable
Parameter Setup
Sensitivity = 0 5
Max Height 230 Centimeter (0~300)
Min Height 100 Centimeter (0~200)

[7] Record

Record Delay 10 Sec. (10~300)
[7] Relay-out E 2
Alarm Delay 10 Sec. (10~300)
[7] Send Email
[v] Snapshot
| Default I | Refresh | l Save

Figure 5-69
Step 2
Select ‘Enable” and it will enable the function of stereo.
Step 3
Click ‘Draw Rule” and it can draw detection area in the monitoring image.
Step 4
It is to set the parameters of stand detection, please refer to the following table for more details.
Parameter Function
Sensitivit It is to set the sensitivity which triggers alarm. The bigger the sensitivity is, the
Y easier it becomes to trigger alarm.
Max Height It is to set the max height which triggers alarm when object or people stand
there.
Min Height It is to set the min height which triggers alarm when object or people stand
there.
Period It is to set the alarm period, it can enable alarm event only during the period
range which has been set. Please refer to Step 3 of 5.3.7.1 Heat Map for
period setting.
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Parameter

Function

Record

Check it and so when alarm occurs, system will auto record.

Note

The system record needs to meet the following two conditions:

® Motion record has been enabled; please refer to 5.4.1.1 Record Schedule
for more details.

® Auto record has been set; please refer to 5.4.3 Record Control for more
details.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so that
system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email Select “Send Email”, the system will send email to inform users when alarm
occurs. Please refer to 5.2.6 SMTP (Email) for email setting.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when

alarm occurs.
Note

® Motion snapshot has been enabled; please refer to 5.4.1.1 Record Schedu

for more details.
® Please refer to 5.4.2.1 Path for snapshot storage query and setting.

5.3.4.2 Calibration Config
It is to configure the device installation height and angle.

Step 1

Select “Setting > Event > Stereo > Calibration Config” and the system will display the interface of
“Calibration Config”, which is shown in Figure 5-70.

IP Camera

Camera
Network
Event

> Video Detection
> Audio Detection

> Smart Plan

> Face Detection

> HeatMap
> Alarm
> Abnormality

Storage

System

Information

> People Counting

Rule Config alibration Config

Installation Height 0 Centimeter (0~1000)

Installation Angle 0 * (0~90)

Refresh ‘ ‘ Save

Figure 5-70
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Step 2

Click “round” and draw rectangular box in the monitoring image.

The device will calculate its own height and angle relative to the ground.
Step 3

Click “Save” to complete config.

5.3.5 Face Detection

Step 1

Select “Setup > Event > Face Detection” and the system will display the interface of “Face Detection”,
which is shown in Figure 5-71.

IP Camera e e P e e
®@

Camera Face Detection

’:‘efv“’mk [V] Enable

> Video Detection Working Period

> Audio Detection

> SmartPlan "] Enable Face Enhancement

[7] Record
Record Delay 10 Second (10~300)
] Relay-out
Alarm Delay 10 Second (10~300)

i Z.I:r:::ma\'ty ] Send Email

storage [v] Snapshot

System /

IRforation I | Default ' | Refresh 1 | Save

TargetFilter @ Max Size ®
() Min Size *
Figure 5-71
Step 2
Select “Enable” to enable face detection function.
Step 3
It is to set the parameters of face detection, please refer to the following sheet for more details.
Parameter Function
Period It is to set the alarm period, it can enable alarm event only during the period

range which has been set. Please refer to Step 3 of 5.3.7.1 Heat Map for
period setting.

Select “Enable Face Enhancement” and it will guarantee that the face is

Enable Face - .
clear by priority when the stream is set very low.

Enhancement
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Parameter Function
Record (Nihteck it and so when alarm occurs, system will auto record.
ote
The system record needs to meet the following two conditions:
® Motion record has been enabled; please refer to 5.4.1.1 Record
Schedule for more details.
® Auto record has been set; please refer to 5.4.3 Record Control for more
details.
Record Delay System can delay the record for specified time after alarm ended.
Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email Select “Send Email”, the system will send email to inform users when alarm
occurs. Please refer to 5.2.6 SMTP (Email) for email setting.
Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.
Note
® Motion snapshot has been enabled; please refer to 5.4.1.1 Record
Schedule
for more details.
® Please refer to 5.4.2.1 Path for snapshot storage query and setting.
Step 4

Click “Save” to complete the setup of face detection.

5.3.6 People Counting

Note

The precondition is to select “Setup > Event > Smart Plan” and enable the master switch of
corresponding intelligent analytics.

It can check people counting data in the form of report.

5.3.6.1 People Counting

The system makes statistics upon the people flow within the detection area; it will trigger alarm and
activate settings when the people flow exceeds the number of people which has been set in advance.

In Area No.

It is to set a closed area via the function of “In Area No.”, the system will make statistics upon the people
flow within the area, it will trigger alarm when the people flow exceeds the number of people which has
been set in advance.

Step 1

Select “Setting > Event > People Counting” and the system will display the interface of “People
Counting”, which is shown in Figure 5-72.
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Default I l Refresh I | Save
Figure 5-72
Step 2
Set “Rule” as “In Area No.”.
Step 3
Select “Enable” and it will enable the function of people counting in area.
Step 4
Click “Draw Area” and draw detection area in the monitoring image.
Step 5
It is to set the parameters of people counting, please refer to the following table for details.
Parameter Function
Threshold It will trigger alarm when the number of people exceeds the threshold which
has been set.
Type It can select “=Threshold or <Threshold” according to the setting of
threshold.
Sensitivity It is to set the sensitivity which triggers alarm. The bigger the sensitivity is,
the easier it becomes to trigger alarm.
Max Height It is to set the max height which triggers alarm when object or people stand
there.
Min Height It is to set the min height which triggers alarm when object or people stand
there.
0SD Select “OSD” and it can display internal number statistics in the monitoring
image.
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Parameter Function

Period It is to set the alarm period, it can enable alarm event only during the period
range which has been set. Please refer to Step 3 of 5.3.7.1 Heat Map for
period setting.

Enable Face Select “Enable Face Enhancement” and it will guarantee that the face is

Enhancement clear by priority when the stream is set very low.

Record Check it and so when alarm occurs, system will auto record.

Note

The system record needs to meet the following two conditions:

® Motion record has been enabled; please refer to 5.4.1.1 Record
Schedule for more details.

® Auto record has been set; please refer to 5.4.3 Record Control for more
details.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email Select “Send Email”, the system will send email to inform users when alarm
occurs. Please refer to 5.2.6 SMTP (Email) for email setting.
Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.
Note
® Motion snapshot has been enabled; please refer to 5.4.1.1 Record
Schedule
for more details.
® Please refer to 5.4.2.1 Path for snapshot storage query and setting.
Step 6

Click “Save” to complete config.

People Counting

The system makes statistics upon the people flow within the area via the function of “People Counting”,
it will trigger alarm when the people flow exceeds the number of people which has been set in advance.

Step 1

Select “Setting > Event > People Counting” and the system will display the interface of “People
Counting”, which is shown in Figure 5-73.
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Step 3
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|
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Figure 5-73

Counting”.

will enable the function of people counting within the area.

Click “Draw Area” and it can draw detection area in the monitoring image.

Step 5
Click “Draw Rule” and it can set the people counting rule of entering and leaving the detection area.
Step 6
It is to set the parameters of people counting, please refer to the following table for more details.
Parameter Function
Sensitivity It is to set the sensitivity which triggers alarm. The bigger the sensitivity is,
the easier it becomes to trigger alarm.
Max Height It is to set the max height which triggers alarm when object or people stand
there.
Min Height It is to set the min height which triggers alarm when object or people stand
there.
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Parameter

Function

OSsD

Select “OSD” and it will display enter and leave people number statistics in
the monitoring image. Click ‘Clear” to reset the statistics.

Flowrate Alarm

It is to set enter number, leave number and stranded number; it will trigger
alarm when it reaches the limited number.

Record

Check it and so when alarm occurs, system will auto record.

Note

The system record needs to meet the following two conditions:

® Motion record has been enabled; please refer to 5.4.1.1 Record
Schedule for more details.

® Auto record has been set; please refer to 5.4.3 Record Control for more
details.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email Select “Send Email”, the system will send email to inform users when alarm
occurs. Please refer to 5.2.6 SMTP (Email) for email setting.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when

alarm occurs.

Note

® Motion snapshot has been enabled; please refer to 5.4.1.1 Record
Schedule
for more details.

® Please refer to 5.4.2.1 Path for snapshot storage query and setting.

5.3.6.2 Calibration Config
It is to configure the device installation height and angle.

Step 1

Select “Setting > Event > People Counting > Calibration Config” and the system will display the interface
of “Calibration Config”, which is shown in Figure 5-74.
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Figure 5-74

Step 2

Click “Ground” and draw rectangular box in the monitoring image.

The device will calculate its own height and angle relative to the ground.
Step 3

Click “Save” to complete config.

5.3.6.3 People Counting Report

It is a form to generate a report according to people counting statistics.

Step 1

Select “Setting > Event > People Counting > People Counting Report” and the system will display the
interface of “People Counting Report”, which is shown in Figure 5-75.
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Report Type | Daily B Start Time | 2017-11-22 00 EndTime |2017-11-22 17 *Daily report max range is 24 hours

Flow Direction V| Enters [v| Exits [v] Display No. Report Type @ Bar Chart Line Chart

Search I | I

%

0613 08:00 06130900 084131000 081131100

Figure 5-75

Step 2
It is to set search condition, please refer to the following table for details.

Parameter Note

It is to set the report cycle and presentation form, it can select day report, month

Report Type report or year report. The presentation form can select bar chart or line chart.
Start Time It can set the start time of people counting report.
End Time It can set the end time of people counting report.

Flow Direction | It can select the direction of people flow, you can select enter or exit.

Display No. Select “Display No.” and it can display the enter or exit number in the report.

Step 3
Click ‘Search” to complete report statistics, click “Export” to export the people counting report.

5.3.7 Heat Map

5.3.7.1 Heat Map

It is the density statistics of moving object that can generate report, the color range is from blue to red,
blue means the min heat value and red means the max heat value.

Mirroring, view angle change and heat map original data will be cleared.

Step 1

Select “Setup > Event > Heat Map > Heat Map” and the system will display the interface of “Heat Map”,
which is shown in Figure 5-76.
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Figure 5-76

Step 2

Select “Enable” to enable heat map function.

Step 3

It is to set the working period.

1. Click “Setup” and the system will display the interface of “Working Period”, which is shown in
Figure 5-77.

Working Period X |
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Sy
Wednesday W
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™ an ¥ sunday I Menday I Tuesday I Wednesday I Thursday I Friday ™ Saturday
I Period1: | 00 : 00 : 00 | -| 23 : 59 : 59 |
I Pericd2: | 00 : 00 : 00 |-| 23 : 69 : &9 |
I Pericd3: | 00 : 00 : 00 |-| 23 : 69 : &9 |
I Pericd4: | 00 : 00 : 00 |-| 23 : 69 : &9 |
I Pericds: | 00 : 00 : 00 |-| 23 : 69 : &9 |
[ Periods: | 00 : 00 : 00 |-| 23 - 59 : 59 |

| Save | | Cancel




Figure 5-77

It is to set working period according to the following methods:

You can input time numerical value or press the left mouse button to drag on the setup interface to

set.

® There are six periods to be set every day, select the check box in front of the period, and then the
period is valid.

® Select week number (it selects Sunday by default, if it selects the whole week, then it means the
setup can be applied to the whole week, you can also select the check box in front of the week
number to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

o N

Step 4
Click “Save” to complete the setup of heat map.

5.3.7.2 Report

It is to generate the form of report according to the heat map data.

Step 1

Select “Setup > Event > Heat Map > Report” and the system will display the interface of “Report”, which
is shown in Figure 5-78.
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Figure 5-78

Step 2
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It is to set begin time and end time.

Step 3

Click “Search” to complete report statistics, click “Export” to export the statistics report.

5.3.8 Alarm

Please note some series products do not support this function.

5.3.2.1 PIR alarm

The alarm activation interface PIR alarm is shown as in Figure 5-79.
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Default I | Refresh 1 | Save

Figure 5-79
Please refer to the following sheet for detailed information.
Parameter Function
Enable After enabled, relay activation will work. Check it and enable the
PIR alarm.
Working ® This function becomes activated in the specified periods.
period ® There are six periods in one day. Please draw a circle to
enable corresponding period.
® Select date. If you do not select, current setup applies to
today only. You can select all week column to apply to the
whole week.
® Click OK button, system goes back to motion detection
interface; please click save button to exit.
Note: User can set via dragging mouse while not releasing left
mouse.
Anti-dither System only memorizes one event during the anti-dither period.
The value ranges from Os to 100s.

101



Parameter

Function

Flash After enabling, the system will automatically turn on the flash
when alarm occurs.
Flash Delay e The flash will be off with a period of time delay when the
alarm linkage is over.
* Time is calculated by unit of second and ranges from
10s~300s.
Record System auto activates motion detection channel to record once

alarm occurs (working with motion detection function).

Record Delay

System can delay the record for specified time after alarm ended.
The value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output
port so that system can activate corresponding alarm device when
alarm occurs.

Alarm delay System can delay the alarm output for specified time after alarm
ended. The value ranges from 10s to 300s.

Send Email After this function is enabled, system can send out email to alert

you when alarm occurs and ends.

Audio Linkage

Check it and the system will play alarm audio file when alarm
occurs. Users can set recorded audio file in “Camera Setting >
Audio >Alarm Audio”.

Snapshot

After you enabled snapshot, the system will automatically
snapshot if alarm occurs.

5.3.8.1 Alarm Linkage

IP Camera

Camera PIR Alarm

NabhoH I™ Enable

oY Relay-in
> Video Detect

> Audio Detect Working Period
> IVS Analyse Anti-Dither

> Face Detect I Fiash
> People Counting

> Heat Map

Flash Delay
¥ Record
Record Delay

Abnormali
% 2/ ¥ Relay-out

Storage

Alarm Delay
System

I” send Email
Information

I™" Audio Linkage

I Snapshot

Relay Activation Flash Set Audio Detect

Alarm1 e

0 Second (0~100) Sensor Type |NO frd

10 Second (10~300)

10 Second (10~300)

10 Second (10~300)

Default | \ Refresh | \ Save

Figure 5-80
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Parameter Function

Enable Check it and enable the alarm linkage.

Relay-in The default alarm 1, some products can choose alarm 2.

Two types of sensor which are normally open (NO) and normally closed (NC),
Sensor Type switch from normally open to normally closed, open the alarm. Switch from normally
closed to normally open, shut the alarm.

Check it and set PTZ movement when alarm occurs. Such as go to preset x when
PTZ there is an alarm.

The event type includes: preset, tour and pattern and so on.

5.3.8.2 Flash Set

IP camera | ve [ Papsek [ sewp | asm [ Logour |

e PIR Alarm Relay Activation Flash Set Audio Detect

Network
Event m Weak (=) 0 Strong

> Video Detect v Al V¥ Sunday ™ Monday ™ Tuesday ™ Wednesday W™ Thursday W Friday ™ Saturday

> Audio Detect V¥ Period 1: 00 00 00 23 2 59 & 59

[ ot [[ Rewesn [[  sae

> IVS Analyse

> Face Detect
> People Counting
> Heat Map

> Abnormality
Storage
System

Information

Figure 5-81
Parameter Function
ON/OFF ON means flash is on; OFF means flash is off.
Weak-strong Via dragging this bar to adjust flash brightness.
bar
All Check and it means the day flash works.
Period Period that flash is on.
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5.3.8.3 Audio detection

Note: Audio detection won’t work when “Talk” is enabled on the preview interface.
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PIR Alarm Relay Activation Flash Set Audio Detect

Camera

Network

> Video Detect

> Audio Detect

> IVS Analyse

> Face Detect

> People Counting

> HeatMap
Alarm
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Storage
System
Information
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Threshold
Working Period

" Flash
Flash Delay Second (10~300)

¥ Recard
Record Delay Second (10~300)

¥ Relay-out
Alarm Delay Second (10~300)

I” send Email

I Audio Linkage

I 'Snapshot

Defauit l | Refresh

Figure 5-82
parameter Function
Enable Check it and enable audio detection.
Threshold Ittr\]/\r/gls;[]r(l)?ger alarm and set up a series of linkage when volume exceeds the set

5.3.9 Abnormity
Abnormity includes No SD Card, Capacity Warning, SD Card Error, Disconnection, IP Conflict and

Unauthorized Access.

Note:

Only device with SD card function has these three statuses: No SD card, capacity warning, and SD card
error. Device without SD card function does not have the above three statuses. See Figure 5-83 to

Figure 5-85.
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Figure 5-83
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Figure 5-84
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Figure 5-85

Please refer to the following sheet for detailed information.

Parameter | Function

Enable Check to alarm when SD card is abnormal.

Relay-out Check to enable relay-out alarm.

Relay out | The alarm output can delay for the specified time after alarm stops. The
delay value ranges from 10s to 300s.

Note:

No SD card, capacity warning, SD card error, relay-out delay all start
from alarm occurs.

Send After you enabled this function, the system can send out email to alarm
email the specified user.

This function is invalid when network is offline or IP conflict occurs.

SD Card User can set SD card capacity that is left free. When SD card space left
Capacity | is smaller than this limit, alarm occurs.
Limit

When device is offline or IP conflicts, the abnormal alarm is similar with case of SD card error.
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Figure 5-86

When login password keep been wrong for a few times, unauthorized access alarm occurs. This
operation is similar to SD card error. Allow login error times as when it exceeds this limit, user account
will be locked.
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Camera SD Card
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Relay-out
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Figure 5-87

5.4 Storage Management

5.4.1 Schedule

Before schedule setup, user must set record mode is auto or manual.

Note:

If record mode in record control is off, then device will not take snapshot according to schedule.
5.4.1.1 Record Schedule

Record schedule steps:

Step 1. Click on Record Schedule, see Figure 5-88.
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Camera Record Schedule
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Figure 5-88

Step 2. From Monday to Sunday select record time, click on setup on the right, see Figure 5-89.
® Set period according to actual need. There are six periods available each day.
® By checking or unchecking, you can add or delete three types of record schedule: General, Motion,

and Alarm.
Note:
Period setup can be done by dragging in record schedule interface while not releasing left mouse.
Setup % |
[ Al ¥ sunday I~ Wonday I Tuesday [T Wednesday [ Thursday I Friday I Saturday [ Holiday
Period 1: 00 : 00 : 00 |-| 23 : 59 : 59 | [T General M motion [ Alarm
Period 2: 00 - 00 : 00 |-| 23 : 59 : 59 | [T General [T Mmaotion I Alarm
Period 3: 00 : 00 : 00 |-| 23 : 59 : 59 | [T Genmeral I Motion [ Alarm
Period 4: 00 - 00 : 00 |-| 23 : 59 : 59 | [ General [T Maotion [ Alarm
Feriod 5: 00 : 00 : 00 |-| 23 : 89 : 59 | [T General I Motion I Alarm
Period 6: 00 - 00 : 00 |-| 23 : 59 : 59 | [ General [T Maotion [ Alarm
| Save ‘ ‘ Cancel |
Figure 5-89

Step 3. Click on OK, return to record schedule interface. See Figure 5-90.
® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.

® Red color stands for the alarm record/snapshot.
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IP Camera

Camera Record Schedule

Network
General | Motion

¥ Alarm W

Event
Sunday |
Schedule
e Monday
> Destination
> Record Control Tuesday |
System Wednesday
Information Thursday
Friday
Saturday
Holiday

Figure 5-90

Step 4. In record schedule interface, click on OK. System prompts it is successfully saved.

5.4.1.2 Snapshot Schedule
Snapshot setup as:
Step 1. Click on Snapshot Schedule tab, see Figure 5-91.

IP Camera

Camera Record Schedule

Network

[¥] General @ [¥] Motion [¥] Alarm @

Event
Sunday [
Schedule
e Monday
> Destination
> Record Control UEZEE |
System Wednesday
Information Thursday
Friday
Saturday
Holiday
Defait || Refesh || sawe
Figure 5-91

Step 2. From Monday to Sunday select snapshot time, click on setup on the right. See Figure 5-92.
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® Set snapshot period according to actual need. There are six periods available each day.

® By checking or unchecking, user can add or delete three types of snapshot schedule: General,
Motion and Alarm.

Note: Period setup can be done by dragging in snapshot schedule interface while not releasing left

mouse.

Setup [ %]
Al ¥ sunday [ Monday I Tuesday [~ Wednesday [ Thursday [ Friday [ Saturday [ Holiday
Periad 1: 00 - 00 : 00 |-| 23 : 59 : 59 | [ cGeneral W Motion [ Alarm
Period 2: 00 : 00 : 00 |-| 23 : 59 : 59 | [C ceneral I Motion [ Alarm
Period 3: 00 - 00 : 00 |-| 23 : 59 : 59 | [ cGeneral I Motion [ Alarm
Periad 4: 00 - 00 : 00 |-| 23 : 59 : 59 | [" ceneral I Motion [~ Alarm
Period 5: 00 - 00 : 00 |-| 23 : 59 : 59 | I[” ceneral I~ Motion [~ Alarm
Period : 00 : 00 : 00 |-| 23 : 89 : 59 | [ General [ mMotion [ Alarm
| Save | | Cancel |
Figure 5-92

Step 3. Click on OK, return to snapshot schedule interface. See Figure 5-93.
® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.

® Red color stands for the alarm record/snapshot.

IP Camera

Camera Record Schedule

L= General W [v] Motion Alarm m
Event
0 2 4 6 8 10 12 14 16 18 20 2 24
Sunday
Schedule
> Destination Menday
» Record Control Mz Setup
System Wednesday
Information Thursday Setup
Friday
Saturday
Holiday Satup
Defout || Refresh || saw
Figure 5-93
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Step 5. In snapshot interface, click on OK. System prompts it is successfully saved.

5.4.1.3 Holiday Schedule
Holiday schedule can set specific date as holiday.
Step 1. Click on Holiday Schedule tab, see Figure 5-94.

IP Camera

Camera Record Schedule

Network
etwor [[] Record [_] Snapshot

Calendar

Sun Mon Tue Wed Thu Fri Sat

Event

Storage
> Destination
> Record Control 89| 1e||115112[]13 |14
System 15

Information

Refresh ‘ | Save

Figure 5-94

Step 2. Select date to set as holiday. The selected date will be highlighted in yellow.

Step 3. Check Record/Snapshot, click on Save. System prompts it is successfully saved.

Step 4. Check Record Schedule/Snapshot Schedule interface, click on setup next to Holiday, and refer
to setup of Monday to Sunday.

Step 5. Complete setup of holiday, then it records/snapshots according to date in holiday schedule.

5.4.2 Destination

5.4.2.1 Path

The destination interface is shown as in Figure 5-95.

Path can config record and snapshot storage path. There are three options: Local, FTP and NAS. You
can only select one mode. System can save according to the event types. It is corresponding to the

three modes (general/motion/alarm) in the Schedule interface. Please check the box to enable the save
functions.

Note: Only device supports SD card has local.
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IP Camera

Camera Path

etwork Record Snapshot
Event Event Type Scheduled Motion Detect Alarm Event Type Scheduled Motion Detect Alarm
sofage Local [v] vl v Local ¥ [v] [©]
ZiScheouo FTP @ O ] FTP ] @ O
NAS ] I [l NAS | [l [
s Default “ Refresh || Save
System
Information
Figure 5-95
Please refer to the following sheet for detailed information.
Parameter | Function
Event It includes: scheduled, motion detect and alarm.
Type
Local It saved in the SD card.
FTP It saved in the FTP server.
NAS It saved in NAS disk.
5.4.2.2 Local

The local interface is shown as in Figure 5-96.
Here you can view local Micro SD card or NAS disk information. You can also operate the read-only,
write-only, hot swap and format operation.

IP camera

Camera

PElWO K Status Attribute Used CapacityTotal Capacity
Disk1 Normal Read & Write — | 6131.4M7578 1M
> Schedule
Information
ReadOny |[ Readawrte ][ Hotswap |[  Refresn
Figure 5-96

54.23 FTP
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The FTP interface is shown as in Figure 5-97.
You need to check the box to enable the FTP function. When network disconnect occurred or there is

malfunction. Emergency storage can save the record/snapshot picture to the local SD card. Click the
test button to check if the FTP server can be connected for test.

IP Camera

Camera Path

Network
o Enable

Server Address
Port

User Name
s )
> Record Control hasaan

Remote Directory

System
Information Emergency (Local)

21

anonymity

share

(0~65535)

Default

|| Retesn |[  sae

5.4.2.4 NAS

Figure 5-97

You need to check the box to enable the NAS function. Select NAS storage, fill in NAS server address
and corresponding store path, then you can store video file or pictorial information in the NAS server.

See Figure 5-98.

IP Camera

Camera Path
Network

Event

Enable
Server Address

Remote Directory

> Schedule

> Record Control
System

Information

Refresh | |

Figure 5-98

Parameter Function

Server Address | Set IP address of NAS server.

Remote Set storage directory, videos and pictures can be stored in to corresponding server
Directory directory.
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5.4.3 Record control
The record control interface is shown as in Figure 5-99.

IP Camera

Camera Record Control

Network
Event

2 Disk Full
> Schedule

> Destination

System

Information

Pack Duration

Pre-event Record

Record Mode

Record Stream

8 Minute (1~120)

5 Second (0~5)

Overwrite [+]
© Auto O Manual ©) Off
Main Stream [+]
Defauit l | Refresh | | Save

Figure 5-99
Please refer to the following sheet for detailed information.
Parameter | Function
Pack Here you can select file size within 1min~120min. Default setup is 8
Duration minutes.
Pre-record | Please input pre-record value here.
For example, system can record the four seconds video in the buffer.
The record begins from the fifth second.
Note:
Configure pre-record time, when alarm or motion detection occurs, if
there is no record, system will record the preceding n seconds
record.
Disk Full There are two options: stop recording or overwrite the previous files
when HDD is full.
® Stop: Current working HDD is overwriting or current HDD is full,
it will stop record.
® Overwrite: Current working HDD is full; it will overwrite the
previous file.
Record There are three modes: Auto/manual/close.
mode
Record There are two options: main stream and sub stream.
stream
5.5 System
5.5.1 General

The General interface is shown as in Figure 5-100.
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IP camera

Camera General
Network

Event
Language
Storage

TvOut

» Default
> Import/Export

¥ Auto Maintain

> Upgrade

Information

Device Name

Video Standard

Date&Time

YZC4DZ021W00009

English E
PAL [+]
Open E

Default | ‘ Refresh | | Save

Figure 5-100
Please refer to the following sheet for detailed information.

Parameter | Function

Device Itisto set device name. .

Name Note: Different devices have different names.

Video This is to display video standard such as PAL.

Standard

Language You can select the language from the dropdown list.

TV Out You can open or close the function, it can only be supported by the
devices with TV Out.
® Intelligent function will be disabled when TV Out is opened.
® |t will auto close TV Out when intelligent function is enabled.
® Some devices support SDI and HDCVI.

The Date & Time interface is shown as in Figure 5-101.
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IP Camera

Camera General Date&Time

Network
Date Format Year-Month-Day [zl
Event .
Time Format 24-Hour-based System El
Storage
Time Zone GMT+08:00 [~
Current Time 2015 - 03 - 26 10 00 : 08 SyncPC
S Account ["] DST Enable
> PTZ Settings DST Type @ Date ) Week
> Default Start Time Jan [+] 1 [=] o0 : 00 :
> ImportExport End Time Jan E] 2 E| 00 : 00
> Auto Maintain ["] Synchronize with NTP
> Upgrade NTP Server clock.isc.org
Information Port 123
Update Period 10 Minute (0~30)
Defaut [ Rewesn [ saw

Figure 5-101

Please refer to the following sheet for detailed information.

Parameter Function

Date format | Here you can select date format from the dropdown list.

There are two options: 24-H and 12-H.

Time

Format

Time zone | The time zone of the device.

Current It is to set system time. It becomes valid after you set.

Time

Sync PC You can click this button to save the system time as your PC current

time.

DST Enable | Here you can set both begin and end time of daylight saving time.
You can set according to the date format or the week format.

Synchronize | You can check the box to enable NTP function.

with NTP

NTP server | YOU can set the time server address.

Port It is to set the time server port.

Update It is to set the sync periods between the device and the time server.
period

5.5.2 Account
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® For user name and user group, the max length is 31 characters, which can be made up of digit,
letter, underline, hyphen, dot and @.

® Password can be 0~32 characters in number and letter only. User can modify other user’s
password.

® User and group can be manually added to 18 and 8 respectively.

® User management adopts group/user modes. The user name and the group name shall be unique.
One user shall be included in only one group.

® Currently logged in user cannot change his/her own right.

5.5.2.1 Username
In this interface you can enable anonymity login, add/remove user and modify user name. See
Figure 5-102.

IP Camera

Camera Account

Network

[] Anonymous Login
B User Name Group
No. User Name Group Name Remark Modify Delete

Sustem 1 admin admin admin ’s account £ =]

Storage

> General

> PTZ Settings

> Default
> Import/Export
> Auto Maintain

> Upgrade

Information Authority List

Live Playback Record Control Backup PTZ Account
Alarm Log Search Clear Log Upgrade Auto Maintain General
Video/Audio Schedule/Destination Network Abnormality Video Detect PTZ Settings
D Ci i Vs

Figure 5-102

Enable anonymity login: Enable anonymity login, and input IP. No username or password is required,
you can log in by anonymity (with limited rights). You can click logout to end your session.

Add user: Itis to add a name to group and set the user rights. See Figure 5-86.

Hidden user “default” is for system interior use only and cannot be deleted. When there is no login user,
hidden user “default” automatically login. You can set some rights such as monitor for this user so that
you can view some channel view without login.

Here you can input the user name and password and then select one group for current user.

Please note the user rights shall not exceed the group right setup.

For convenient setup, please make sure the general user has the lower rights setup than the admin.
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Add User B

LserMame
Fassword
Confirm Password

Group IHII|I'|'|iI'| j

Femark

Autharity List M Al
W Live i’
M Playback
I Record control

¥ Backup =l

Save Cancel

Figure 5-103

Modify user

It is to modify the user property, belonging group, password and rights. See Figure 5-104.

Modify password

It is to modify the user password. You need to input the old password and then input the new password
twice to confirm the new setup. Please click the OK button to save.

Please note, the password ranges from 0-digit to 32-digit. It shall include the number and letter only. For
the user who has the account rights, he can modify the password of other users.
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Modify User

User Mame

I™ Modify Password
Group
Remark

Authority List

|admin j

|a:lmin j
admin "s account
M Al
W Live
M Playback
¥ Record control

¥ Backup

Save Cancel

5.5.2.2 Group

The group management interface can add/remove group, modify group password and etc.

Figure 5-104

The interface is shown as in Figure 5-105.

IP Camera

Camera Account
Network

[] Anonymous Login
Event

User Name
Storage No.
S 1 admin ‘administrator group
> General 2 user user group
> PTZ Settings
> Default
> Import/Export
> Auto Maintain
> Upgrade
Information Authority List
Live Playback Record Control Backup PTZ Account
Alarm Log Search Clear Log Upgrade Auto Maintain General
i Network Abnormality Video Detect PTZ Settings
Defaultimport/Export Conditions Vs

Add Group

Figure 5-105

Add group: Itis to add group and set its corresponding rights. See Figure 5-106.
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Please input the group name and then check the box to select the corresponding rights. It includes:

preview, playback, record control, PTZ control and etc.

Add Group

Group
Remark

Authority List

Modify group

Click the modify group button, you can see an interface is shown as in Figure 5-107.

Y
I Live
" Playback
[T Record contral
[T Backup
Save Cancel
Figure 5-106

Here you can modify group information such as remarks and rights.

Modify Group

Group
Remark

Authority List

|E|clmin
administrator group

¥ Al

=~

5.5.3 Default

¥ Live i’
¥ Playback
V¥ Record control
¥ Backup ~|
Save Cancel
Figure 5-107

The default setup interface is shown as in Figure 5-108.
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Please note system cannot restore some information such as network IP address, account and so on.

IP Camera

Camera Default

Network

Storage

> Upagrade

Information

Figure 5-108

5.5.4 Import/Export
The interface is shown as in Figure 5-109.
IP Camera

Camera Import/Export

HEtwork Backup Path

Event

Storage incg

> Default

_ ImportExport |

> Auto Maintain

> Upgrade

Information

Figure 5-109

Please refer to the following sheet for detailed information.

Parameter | Function

Import It is to import the local setup files to the system.

Export It is to export the corresponding system setup to your local PC.

5.5.6 Remote control

Note:
It is supported by some devices.
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IP camera

Camera Remote

Network

Event Learn Remote it | Learn | | Clear ‘
Storage
svetam Arm/Disarm |Arm ;] | 10s :]

> General
> Account
> Default
> Import/Export

> Auto Maintain

> Upgrade

Information

Figure 5-110
Parameter Function
Learn Bind remote control or wireless alarm with equipment.
Clear Unbind remote control with equipment.

Start arm after the time you choose, disarm comes into effect immediately. Note:

Arm/Disarm With disarm status, all the following alarms won’t trigger: motion detect alarm,
masking alarm, local alarm, PIR alarm, wireless alarm.

5.5.5 Auto Maintenance

The auto maintenance interface is shown as in Figure 5-111.

Here you can select auto reboot and auto delete old files interval from the dropdown list.
If you want to use the auto delete old files function, you need to set the file period.

IP camera

Camera Auto Maintain
Nemork [¥] Auto Reboot Tuesday

Event
[C] Auto Delete OId Files

Manual Reboot

Storage

> General |

Reesn ][ saw

> Account

> ttings
> Default

> Import/Export
> Upgrade

Information

Figure 5-111

122



Parameter Function

Auto Reboot Check it and set auto reboot time.

Auto Delete Old

Files Check it and set period within 1~31 days.

5.5.6 Upgrade

The upgrade interface is shown as in Figure 5-112.

Please select the upgrade file (file extension is “.bin”) and then click the update button to begin firmware
update.

Important
Improper upgrade program may result in device malfunction!

IP Camera

Camera Upgrade

Nertwork Select Firmware File

Event

Storage

> Default
> Impori/Export
> Auto Maintain

 Upgrade

Information

Figure 5-112

5.6 Information

5.6.1 Version

The version interface is shown as in Figure 5-113.

Here you can view system hardware features, software version, release date and etc. Please note the
following information is for reference only.

IP Camera

Camera Version
L Software Version 2.420.0001.0.R, build : 2015-03-26
Event
WEB Version 321259363
Storage
ONVIF Version 242

System

SiN YZC4DZ021W00009

on
_ Copyright 2015 All Rights Reserved.

> Log

> Online User

Figure 5-113
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5.6.2 Log
Here you can view system log. See Figure 5-114.

IP Camera

Camera
Network
Event
Storage
System

Log

> Online User

StartTime | 2015 - 03 - 25 10 02 : EndTime | 2015 - 03 - 26 10

No. Log Time User Name Event

58

Detailed Information

M A1 > MGoTo )

[ we | em | Pawac | sewp | mam [ Logow ]

Figure 5-114

Please refer to the following sheet for log parameter information.

Parameter | Function

Start time Set the start time of the requested log. (The earliest time is 2000/1/1)

End time Set the end time of the requested log. (The latest time is 2037/12/31)

Type Log type.

Search You can select log type from the drop down list and then click search
button to view the list.
You can click the stop button to terminate current search operation.

Log You can select one item to view the detailed information.

information

Clear You can click this button to delete all displayed log files. Please note
system does not support clear by type.

Backup You can click this button to backup log files to current PC.

5.6.3 Online User
The online user interface is shown as in Figure 5-115.
Here you can view current online user, group name, IP address and login time.
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IP Camera

Camera Online User
Network

User Local Group IP Address
admin admin 10.34.9.220 2015-03-26 09:45:22 &

Storage 2 admin admin 10.347.148 2015-03-26 09:55:14
System

Event 1

Figure 5-115
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6 Alarm

Please note some series product does not support this function.
Click alarm function, you can see an interface is shown as in Figure 6-1.
Here you can set device alarm type and alarm sound setup.

(TR (T ST AU ST
(©)

IP Camera

Alarm Type No. Time Alarm Type Alarm Channel

[”] Motion Detection [”] DiskFull

[ Disk Error [”] video Tampering

[T] External Alarm [C] megal Access

["] Audio Detection

[_| Scene Changing
Operation

[T Prompt
Alarm Tone

[T] Play Alarm Tone

Tone Path

[T vs

Figure 6-1
Please refer to the following sheet for detailed information.
Type Parameter Function
Alarm Motion detection | System alarms when motion detection alarm
type occurs,
Disk full System alarms when disk is full.
Disk Error System records alarm info when disk error
happens.
Video System alarms when video is tampering.
Tampering
External alarm Alarm input device sends out alarm.
lllegal Access System alarms when there is illegal access.

Audio Detection

System alarms when there is audio detect.

IVS

System alarms when IVS event is triggered.

Scene Changing

System will record alarm info when triggering
scene changing.
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Type

Parameter

Function

Operation

Prompt

A

When alarm is triggered, there will be s =/
inmain menu of alarm interface and system
automatically records alarm info. The icon
disappears when user click on alarm menu bar.
Note:

If alarm interface is displayed, when alarm is
triggered, there will be no image prompt, but alarm
record will be in list on the right.

Alarm
Tone

Play Alarm Tone

Click it and select the path of audio file to be
played in the tone path, when the subscribed alarm
event triggers, it will play the selected audio file to
prompt that there is alarm event which has been
triggered.

Tone Path

You can customize the storage path of the alarm
tone.
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7 Log out

Click log out button, system goes back to log in interface. See Figure 7-1.

Usemame: | admin

Password:

Figure 7-1
Note
® This manual is for reference only. Slight difference may be found in user interface.
® All the designs and software here are subject to change without prior written notice.
® All trademarks and registered trademarks mentioned are the properties of their respective
owners.
® |[f there is any uncertainty or controversy, please refer to the final explanation of us.
® Please visit our website for more information.
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